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• • 
• • 

1. How to use this guide

This guide provides concise examples for all major topics in an introductory course for control systems. In addition, it provides 
essential Maple concepts techniques that will help in most topics in engineering.

Overall, this guide is intended to help you build your Maple proficiency in a way that helps you enhance your mastery and 
comprehension of the many complex topics in the course. Maple is a professional tool for performing a wide range of math 
operations that would normally take you minutes and sometimes hours to do. With the right Maple skills, you will be able to 
streamline your assignment, and project work. More importantly, it will save you time so that you can redirect your study efforts to
understanding the course concepts rather than chasing down a math mistake. In this way, Maple is NOT a substitute for doing your
course work. Even if Maple can do a problem instantly, you will still need to build up manual proficiency in the basic techniques 
of this course as you will need these basic skills to succeed in tests and exams where you will not have access. The best way to use
Maple is to buy yourself time to check answers that you try by hand, do a few more problems without spending huge amounts of 
additional time, and try some textbook problems that do not have answers in the back of the book.

Organization of the guide

Sections 1.0 and 2.0 provide the basic Maple techniques that are useful for any topic. 
Sections 3.0 to 7.0 provide a series of short examples for all of the major topic areas encountered in a typical course. You will 
be able to look up the topic of interest and find a quick example to help you use Maple for that topic.

It is strongly recommended that you work through sections 1.0 and 2.0 first. Maple is a sophisticated system with a huge range of 
options. The first sections provide essential tips and recommendations to help you sort out all of the possibilities.

Working through the examples

This guide is written as a Maple document file, which means all math contained here is live and you can do things directly in this 
document. The recommended approach however is to work with a blank document file and work through the examples separately. 
Although the Maple document environment lets you execute all of the example within this document, you can quickly make a real 
mess of the document content by working directly with the original material. Working through on a separate document is also a 
good way to practice your equation entry. Once you master Maple's ability to compose and displace complicated math, you will 
find that Maple's math environment is one of the fastest and most intuitive ways for working with large amounts of mathematical 
information.

Explanation of symbols

Throughout the guide you will see three symbols attached to various portions of the content.

  This denotes "Clickable" content and refers to Maple techniques to use the mouse, menus, and other more interactive 

ways of solving problems. In many ways, this is the modern Maple approach.

 This denotes the command approach to Maple problem-solving. Sometimes, it is not possible to compute certain 

complex things using the clickable methods. For those cases, the examples rely on Maple's extensive range of commands. This is 
the traditional way of using Maple and one that you might see in a lot of older books and guides.

This symbol denotes "Exploration" and marks special content designed to help you explore particular complex topics. 

The vast majority of this guide is focused on developing your proficiency in using this tool for the topic area. The exploration tools
are designed to help you investigate interactively certain key concepts that would be very difficult to show manually.
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For more information on the nature of the content in this guide, see Clickable vs. the Command section.

Go back to Table of Contents

1.1 About Maple 

Maple is the original system produced by Maplesoft for a broad range of mathematical problem-solving. It is best known for 

its "symbolic" computation. Maple can compute full mathematical solutions to problems. For example for 
x

1 Cx2
 dx  it can 

calculate 
ln 1 Cx2

2
 as the answer. Most math systems would only be able to do this problem through "numerical methods" 

which produces a simple approximation for the answer that is often less useful and less efficient than the full mathematical 
answer. Maple was invented at the University of Waterloo in the 1980's and was commercialized by Maplesoft. Today, Maple 
is used by millions of professionals in industry, university, and research institutions around the world.

MapleSim is the newest system from Maplesoft that applies the symbolic capabilities of Maple specifically for engineering 
modeling. It offers a nice graphical user interface to specify complete physical systems and then will use advanced symbolic 
techniques to produce high-performance mathematical models of the system. In control systems, it will help you define system
models and investigate control strategies.

Go back to Table of Contents

1.2 About Maple and MATLAB®

In many textbooks, there will be references to the MATLAB math system and most will even provide short examples of 
important tasks. Maple, in many ways, is a superset of the MATLAB system. It provides all of the basic functions of 
MATLAB but Maple offers more functions for symbolic calculations (and numeric calculations). This option for symbolic 
makes Maple much more suitable for fundamental and theoretical concepts of a course like Control Systems. Also, the Maple 
user interface is much better suited for mathematical work. 

Consider the following example for the definition of a transfer function.

MATLAB Maple

numb = [0 0 100];

denb = [1 10.1 101];

sysb = tf(numb, denb);

sysbd
100

s2 C10.1 sC101

MATLAB is principally a programming language and as such will require mathematics in computer-friendly forms. Maple 
offers several options to represent mathematics in more intuitive ways making it much easier to work with. 

In terms of a Control Systems course, this guide was designed to offer a rich set of examples the go well beyond the selection 
of MATLAB examples that are typically included in standard texts.

Go back to Table of Contents
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2. Maple fundamentals

Maple is an extensive system and offers many ways of performing the same task. The purpose of this guide is to provide simple, 
easy-to-repeat ways of solving common problems and performing common operations. But it is, in no way, the only approach. 
After becoming comfortable with the various techniques shown in this guide, you may wish to browse help system to learn about 
alternate techniques.

2.1 The Maple environment

Maple default user interface is a typical Windows or Mac-like environment. 

The following are the main parts:

The main document which is the primary working area. In fact, if you think about it as Microsoft Word with all sorts of 
extra tools for math and plotting, things make a lot more sense. 

Palettes. Collection of special math tools and symbols that you can drag and drop into your document space. The most 
important ones will be Expressions, Matrix, Common Symbols, and Greek. There are actually about 30 available palettes. To 
see them, right-click on a blank area of the palette region and select Arrange Palettes.
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• • 

• • 

• • 

• • 

• • Toolbars. There are two principal toolbars. The standard toolbar, by default, has things like Save, Zoom, etc., and several 
important Maple-specific items. The context-sensitive toolbar contains tools and operations that are specific to what you 
have clicked (e.g. math, a plot, an animation, etc.). The toolbar will change with each context. The following table outlines  
some of the more important toolbar buttons unique to Maple.

Restart. Click this if you want to clear the 
memory and reset all variable definitions. It is 
a good idea to do this before every example or 
problem to make sure you are not carrying any 
definitions from a previous calculation.

Insert a Text Region after the cursor. This puts 
a blank paragraph and puts Maple into Text 
mode. In this mode you cannot enter math. To 
go into Math mode, press [F5].

 Single exclamation execute all Maple 
calculations in a selection. The three 
exclamations is for executing everything in the
document.

Interrupt computation. Sometimes, large 
problems take longer than you might wish. 
Pressing this button will cancel the 
computation.

Three useful buttons from the Plot context 
toolbar. Respectively, they are the 
pointer/selection mode (default), scaling 
(zooming) mode, and panning (shifting) mode.

Main slider for the Animation context toolbar. 
The slider is used to manually control the 
animation. Other buttons allow for automatic 
playing.

Input and output. Any math that is displayed in real mathematical form is theoretically live and can be executed. However, 
in real life, you will want some math to be executed while others are used in sentences for explanation purposes. In this 
guide, for almost all examples, the executable math is in a separate line of its own. This is considered the input. The output 
is then displayed in blue and typically centered on the screen.

Plot and graphics regions. Plots, animations, static images, and other elements can be included into a document.

Sections and subsections. You can group content into collapsible sections and subsections. Click on the little grey triangle to
expand or collapse.

Go back to Table of Contents

2.2 Before you start ...

Remembering a few simple rules even before you have a clear idea of what this system does will help the first learning steps a 
lot easier. Most beginning Maple users first stumble here and there with the user interface. The following tips will help smooth
out the first hours. Simply memorize these tips for now. 

Maple has modes. This means if you are not in the right mode, you will not be able to access certain features. To work with 
examples in this guide, the most important mode is the Math mode -- i.e. the mode where you can enter and work directly 
with math expressions. There are more details on this topic in Formats and modes.
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• • 

• • 

• • If your math looks like this: s+a/s^2  , press [F5] or press the  button. You got yourself into Text mode when

you should be in Math mode.

For most cases, the opposite of Math mode is Text mode which is used for entering regular paragraphs of text. In Text mode,
Maple will not automatically introduce special formatting to deal with math.  If your text looks like this: if your text looks, 

press [F5] or press the  button. You got yourself into Math mode when you should be in Text mode.

If you are in an exponent or a denominator and you want to get back to the main line of your math, press the right cursor 
key [→].

If you cannot seem to delete something through [Backspace] or [Del], try placing the cursor on the desired line and press 
[Ctl][Del] which is Maple's "Super Delete" for complex information.

Go back to Table of Contents

2.3 Clickable vs. the Command

Maple has two basic approaches to problem solving: the "clickable" approach and the "command" approach.

 The clickable approach is based on the mouse: i.e. using menus, drag-and-drop, clicking on icons, etc. It is highly 

interactive and is very convenient for quick problem-solving and interactive manipulation and exploration of mathematical 
topics.

 The command approach is based on a large set of precise commands or function names that you type in to 

perform specific tasks. This is the preferred way for advanced work and programming.

This guide assumes that you may want to use both methods depending on circumstances and provides, in most cases, both 
clickable and command notation options. The mouse and keyboard symbols shown here will indicate whether the style of the 
example is clickable or command.

 Go back to Table of Contents

2.4 Doing math with Maple

2.4.1 Entering Maple expressions

In Maple, mathematical expressions, such as 
sCa

s2 CsC 2
,  can be entered in a natural 2-D notation. These expressions 

can be used for either clickable or command techniques. Alternatively, if you are progressing to advanced programming, 

you may use  text style 1D notation ( (s+a)/(s^2+s+sqrt(2)) ) .  The command examples in this guide generally 

use the 2D notation.

Go back to Table of Contents



Maple notes for introductory control systems 11

2.4.1.1 Example: 
sCa

s
2
CsC 2

Ensure that you are in Math mode, and follow the steps below to enter the expression 
sCa

s2 C2 sC 2
 .

To begin entering a 2-D mathematical expression, ensure that you are in Math mode. In this mode, the cursor is 
slanted. If the cursor is vertical, you are in Text mode and you cannot do calculations or compose complex math 
expressions. To switch between Math and Text mode, press the appropriate button on the top left of your workspace or
press [F5] to toggle between the two modes.

Before you start, you should reset Maple's memory by clicking the  button on your Maple toolbar.

 Step

Action Result

1 Enter the numerator sCa sCa

2 Highlight sCa and type [/] (slash). The slash 

denotes division.

sCa

3 Begin entering denominator. Type s sCa

s

4 To enter an exponent, type the common power 
character [^]. The cursor is now in the 

exponent position. Type 2.

sCa

s2

5 To bring the cursor back onto the base line, press 
the right arrow [→] key on your keyboard.

sCa

s2

6 Type CsC . There is no need to type a space, as 
Maple automatically adjusts spacing for you.

sCa

s2 CsC

7 To enter a square root, open the expression 

palette on left, and find the [ a ] symbol. Click 
on this. This will insert the symbol into the 
expression. The green a will be highlighted.

sCa

s2 CsC a

8 With the a highlighted, type 2. Then press the 
right arrow [→] key to return to the baseline

sCa

s2 CsC 2

9 Press return to enter the expression into memory. 
Maple will return an "equation number" on the 
right (note, your equation number will likely be 
different than in this example). The number is 
useful later to refer to this expression in a 
calculation.

sCa

s2 CsC 2

sCa

s2 CsC 2
(2.4.1.1.1)
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Alternative to Step 1: Find the [
a

b
] symbol on the expression palette and replace the numerator and denominator with 

the appropriate expressions as above.

Alternative to Step 7: For the square root, type [s][q][r][t] and then [ctl][space] (keep [ctl] pressed). 

You will get a menu of possible Maple symbols beginning with the letters sqrt. Choose the x  option. 

Go back to Table of Contents

2.4.1.2 Example: s
2
C2 ξ ω

0

2
 s C ω

0

2

Ensure that you are in Math mode, and follow the steps below to enter the expression 

 Step

Action Result

1 Enter the numerator sC2. Type an additional [space] sC2 

2 For the Greek letter ξ (xi), type [x][i] then [ctl][space]. The 
letters x and i will immediately switch to the Greek letter. In this
case, there is only one option in Maple for the letters x and i so 
the change is automatic. 

Type an additional [space]

sC2 ξ 

3 For the product ω
0

2
 s:

Type [o][m][e] then [ctl][space]. Switches immediately to the

Greek ω .

• 

Type [ _ ] (underscore) which puts you in subscript mode. 
Type [0] (zero)

• 

press the right arrow [→] key to return to the baseline• 
Type [^] for the exponential then [→] to return to the 
baseline.

• 

Enter s to complete the product.• 

sC2 ξ ω
0

2
 s

4 Complete the expression using the same technique for the ω
0

2
 

term.

sC2 ξ ω
0

2
 sCω

0

2

5 Press return to enter into memory. sC2 ξ ω
0

2
 sCω

0

2

sC2 ξ ω
0

2
 sCω

0

2
(2.4.1.2.1)

Alternative for Greek letters: All Greek letters are also available through the Greek palette. If you do not see a Greek 
palette, right click in the palette area, choose "Show Palette" in the menu then choose Greek.

Alternative for multiplication: In this example, all multiplication was denoted by [space]. You can also explicitly 

specify multiplication by the [*] character. On the display, it will show as a dot (e.g. 2$ξ).

Go back to Table of Contents
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2.4.2 Doing some math on expressions

2.4.2.1 Differentiation using menus and palettes 

 The easiest way of performing basic math operations is via the right-click (also known as "context-

sensitive") menus. Simply right-click (if on a Windows computer) on an expression and Maple will automatically offer

a range of mathematical operations suitable for that expression. Given an expression  s2 C2 ξ ω
0

2
 s C ω

0

2
 , calculate the 

derivative 
d

d ξ
 and 

d

d ω0

 

 Step

Action Result

1 Enter expression  s2 C2 ξ ω
0

2
 s C ω

0

2
. Press 

[Enter]. The blue expression that Maple 
returns is referred to as the "output".

s2 C2 ξ ω
0

2
 s C ω

0

2
 

s2 C2 ξ ω
0

2
 sCω

0

2
(2.4.2.1.1)

2 Place the mouse somewhere on the output 
and press the right mouse button. You will 
see a menu. Choose Differentiate, then 
choose xi. 

Maple returns the answer and adds a little 
note to indicate what just happened. Check 
the answer with your intuition.

s2 C2 ξ ω
0

2
 s C ω

0

2
 

s2 C2 ξ ω
0

2
 sCω

0

2
(2.4.2.1.2)

differentiate w.r.t. xi

2 ω
0

2
 s (2.4.2.1.3)

3 Make a copy of the expression to a new 
line. Enter it. Right-click and differentiate 
with respect to omega[0]. This is how 

Maple represents ω0 within text menus.

s2 C2 ξ ω
0

2
 s C ω

0

2
 

s2 C2 ξ ω
0

2
 sCω

0

2
(2.4.2.1.4)

differentiate w.r.t. omega[0]

4 ξ ω0 sC2 ω0 (2.4.2.1.5)

Alternate method for differentiation: In the Expression palette, there is a symbol 
d

dx
f .  Click on this symbol and you'll

see a template for a single differentiation. You can now replace the x with ξ and f with  s2 C2 ξ ω
0

2
 sCω

0

2
. Note that 

the brackets around the expression was intentional to avoid possible misinterpretation: i.e. 
d

d ξ
s2 C2 ξ ω

0

2
 sCω

0

2
  

vs.  
d

d ξ
s2 C2 ξ ω

0

2
 sCω

0

2
 .

Go back to Table of Contents

2.4.2.2 Differentiation using commands 

Consider the same example of 
d

d ξ
 and  

d

d ω0

.  If you're working with commands, the following are the equivalent 

commands,
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(2.4.2.2.1)(2.4.2.2.1)

(2.4.2.3.1.2)(2.4.2.3.1.2)

(2.4.2.3.1.1)(2.4.2.3.1.1)

(2.4.2.2.2)(2.4.2.2.2)

diff s2 C2 ξ ω
0

2
 s C ω

0

2
 , ξ

2 ω
0

2
 s

diff s2 C2 ξ ω
0

2
 s C ω

0

2
 , ω0

4 ξ ω0 sC2 ω0

Go back to Table of Contents

2.4.2.3  Other math operations on common expressions 

Operation
Clickable 

Given 
1

sC2  sC
1

3

, 

simplify the expression. 

Use right click menu and choose Simplify /  Simplify.
1

sC2  sC
1

3

1

sC2  sC
1

3

(2.4.2.3.1)

=
 simplify 

3

sC2  3 sC1
(2.4.2.3.2)

Using the result from the 
above,
extract denominator• 
expand denominator• 
factor the expanded 
denominator

• 

Use the right click menu for all operations. All operations are at the top level 
of menu.

3

sC2  3 sC1

3

sC2  3 sC1
(2.4.2.3.3)

denominator

sC2  3 sC1 (2.4.2.3.4)

=
 expand 

3 s2 C7 sC2 (2.4.2.3.5)

=
 factor 

sC2  3 sC1 (2.4.2.3.6)

 Command version 

simplify
1

sC2  sC
1

3

3

sC2  3 sC1

denom
1

sC2  sC
1

3

sC2  3 sC1

expand sC2  3 sC1
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(2.4.2.3.1.3)(2.4.2.3.1.3)

(2.4.2.3.1.4)(2.4.2.3.1.4)

3 s2 C7 sC2

factor 3 s2 C7 sC2

sC2  3 sC1

Go back to Table of Contents

2.4.3 The Maple Help system

Maple has an extensive help system. To browse the system, simply go to the Help menu and select one of the various 
options. If you are used to using commands, you can also use the question mark. For example ?dsolve will bring up the 
specific help page for the differential equation solving command dsolve. This is useful if you want more detailed 
information on a command that you see in this guide.

Each Help page contains in-depth technical information on the topic as well as examples that you can copy and paste and 
try out. In some cases the Help system will lead you to a full Maple document with lots of examples for you to try out.

The Help system also includes a full dictionary of math terms. You can access the dictionary either through Mathematical 
Dictionary in the folder pane of the Help browser. If you use the search dictionary on a term like zeta, you will get a 
variety of search hits as both Maple and the math dictionary has entries for the item. The icons beside the hits will indicate 
what kind of entries they are. Often you will also see cross-referencing from a dictionary page to relevant Maple topics and
commands.

Go back to Table of Contents
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(2.4.4.1.1.1)(2.4.4.1.1.1)

2.4.4 Evaluating expressions for different values

Given a Maple expression, you can substitute variable or parameter values. There are many ways to do this and with 
experience, you will develop your own preferences. 

2.4.4.1 Right-click menu 

Evaluate the expression eKa t cos b t Cc, for different values of the unknowns.

Operation
Clickable 

To form eKa t cos b t Cc, the trickiest part 
will be to form the exponential. You cannot 
simply type "e" and raise it to a power. 
Maple will interpret "e" as a variable name 
"e" and not the special number (Euler number
2.718...).

Type [e][x][p][ctl][space]. Choose ex. Type in
the rest taking care of the multiplication sign 
between b and t and making sure there is no 
space between cos and the bracket. Press 
[enter].

eKa t cos b$t Cc

eKa t cos b t Cc (2.4.4.1.1)

Right-click on the output and choose
Evaluate at a point. You will get a dialog box
where you can specify values for the 
unknowns. The result on the right is for 

a =
1

2
 and c = 2.

eKa t cos b$t Cc

eKa t cos b t Cc (2.4.4.1.2)
evaluate at point

e
K

t

2  cos b t C2 (2.4.4.1.3)

Command version 

eval eKa t cos b$t Cc, a =
1

2
, c = 2

e
K

t

2  cos b t C2

Go back to Table of Contents

2.4.4.2 Palette 

 Evaluate the expression eKa t cos b t Cc again for a =
1

2
 and c = 2. This time use the palette. For this, it is useful to 

consider the mathematical form of this task:  eKa t cos b t Cc 

a =
1

2
, c= 2
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(2.4.4.2.1.1)(2.4.4.2.1.1)

Operation
Clickable 

From the Expression palette, choose, 
f x

x = a

 (near the bottom). Replace f x  

with eKa t cos b$t Cc and x = a with 

a =
1

2
, c = 2.

 eKa t cos b$t Cc 

a =
1

2
, c = 2

e
K

t

2  cos b t C2 (2.4.4.2.1)

One trick that makes it easy to compose the 
above in cases when you already have 
expressions defined in your document and 
you want to do complex assignments is to 
first replace the f x  and x = a with empty 
brackets (with 3 spaces in between) and then 
copy and paste your existing expressions. 

   

   

Command version 

eval eKa t cos b$t Cc, a =
1

2
, c = 2

e
K

t

2  cos b t C2

Go back to Table of Contents

2.4.4.3 Equation numbers 

Maple automatically assigns an equation number when you press return to enter an expression or compute an answer. 
The number in the round brackets is the equations number. The number will have more dots if your operation is inside 
nested sections (denoted by the little inverted grey triangles). For example, evaluate the expression 

1

sC2  sC
1

3

 in two steps for s = k$ω.

Operation
Clickable 

Enter k$ω. k$ω

k ω (2.4.4.3.1)

Enter 
1

sC2  sC
1

3

 but at every 

instance of s, press [ctl][l] (lowercase L), 
enter the equation number from first step (i.e.
in this example, (2.4.4.3.1).

1

(2.4.4.3.1)C2  (2.4.4.3.1)C
1

3

1

k ωC2  k ωC
1

3

(2.4.4.3.2)
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(2.4.4.4.5)(2.4.4.4.5)

(2.4.4.4.2)(2.4.4.4.2)

(2.4.4.4.3)(2.4.4.4.3)

(2.4.4.4.1)(2.4.4.4.1)

(2.4.4.4.4)(2.4.4.4.4)

(2.4.4.4.7)(2.4.4.4.7)

(2.4.4.3.1.1)(2.4.4.3.1.1)

(2.4.4.4.6)(2.4.4.4.6)

Command version 

eval
1

sC2  sC
1

3

, s = k ω

1

k ωC2  k ωC
1

3

Go back to Table of Contents

2.4.4.4 Assigning variable names  

This is the traditional way of working with expressions and values. By assigning variable names, you can easily 
manage large sets of equations and variables. For example, the statement

f d sin x

fd sin x

reads, "let the variable f  have the expression sin x ". The special Maple symbol d  ([:][=], no space) is called the 
assignment operator.  The assignment operator is very common when you work with commands. However when you 
are using the clickable features, you can still perform assignments through the menu. The following shows the menu-
based assignment. 

Operation
Clickable Command version 

Define an expression 
and give it the name 
expr. In clickable 
mode, you right click
and select Assign to a
name. Note that 
Maple returns the 
same expression and 
a little note 
indicating that a 
name has been 
assigned. 

1

sC2  sC
1

3

1

sC2  sC
1

3
assign to a name

1

sC2  sC
1

3

exprd
1

sC2  sC
1

3

1

sC2  sC
1

3

Simplify expr and 
name the result 
exprsimp. In 
clickable mode, right
click and choose
Simplify → Simplify.

=
 simplify 

3

sC2  3 sC1
assign to a name

3

sC2  3 sC1

exprsimpd simplify expr

3

sC2  3 sC1
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(2.4.5.1)(2.4.5.1)

(2.4.4.4.8)(2.4.4.4.8)

(2.4.4.4.13)(2.4.4.4.13)

(2.4.5.3)(2.4.5.3)

(2.4.4.4.9)(2.4.4.4.9)

(2.4.4.4.15)(2.4.4.4.15)

(2.4.4.4.12)(2.4.4.4.12)(2.4.4.4.11)(2.4.4.4.11)

(2.4.4.4.16)(2.4.4.4.16)

(2.4.4.4.10)(2.4.4.4.10)

(2.4.5.2)(2.4.5.2)

(2.4.4.4.14)(2.4.4.4.14)

enominator of 
exprsimp and give it 
the name den. In 
clickable mode, right
click and choose
Denominator. 

denominator

sC2  3 sC1
assign to a name

sC2  3 sC1

den d denom exprsimp

sC2  3 sC1

To see the value or 
the assigned 
expression, simply 
type the name of the 
variable and press 
[Enter].

expr

1

sC2  sC
1

3

expr

1

sC2  sC
1

3

You can also string 
together several 
variables and have it 
displayed at once. 
Youcan also use 
variable in other 
formulas and 
expressions.

expr, exprsimp, den
1

sC2  sC
1

3

,

3

sC2  3 sC1
, sC2  3 s

C1

3

den

3

sC2  3 sC1

expr, exprsimp, den
1

sC2  sC
1

3

,

3

sC2  3 sC1
, sC2  3 s

C1

3

den

3

sC2  3 sC1

Once you get to the point of using a larger number of variable names, the advantage of commands over purely 
clickable approaches become obvious: fewer steps and easier to organize complex problems.

The clickable approach is best for short calculations with relatively fewer steps or where you want to make your math 
look as close as possible to formal math as found in books and papers. For multi-step problems, a good grasp of 
Maple's command techniques is extremely helpful.

Go back to Table of Contents

2.4.5 Defining functions f x

When you have mathematical expression, it is common to want to evaluate the function for many different points. For 

example, we want to define a function f = eK t cos 2$t  and you want to calculate f 1 ,  f 2 ,  f 2 π ,  etc.). Although, it 
is easy to evaluate Maple expressions for specific values (we have seen several techniques), if you have many such 
substitutions, you would probably want to have a proper "function" for the calculation.

Consider the following sequence of Maple operations,

fd eKt cos 2$t

eKt cos 2 t

f

t = 1

eK1 cos 2

eval f, t = 1

eK1 cos 2

In both examples, the substitution works as expected. Now try,

f 1
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(2.4.5.1.1.1)(2.4.5.1.1.1)

(2.4.5.4)(2.4.5.4)

(2.4.5.1.1.3)(2.4.5.1.1.3)

(2.4.5.1.1.2)(2.4.5.1.1.2)

eKt 1  cos 2 t 1

The result is not familiar to most of us. This is because Maple has advanced programming functionality that prevents 
simple variables names from being able to flip to a function.

However, once you get past this one aspect, it is quite easy to work with functions quickly and intuitively in Maple. The 
following are two of the most important ways.

Go back to Table of Contents

2.4.5.1 Operator or mapping notation

This step is useful if you have not specified your expressions yet -- i.e. you are at the beginning of your work.

In mathematics, we often use the "mapping" notation for functions. For example, t /eKt cos 2 t  reads, t maps to 

the function eKt cos 2 t . The equivalent can be specified in Maple.

Operation
Clickable 

Define a mapping (function) and
assign the name f.

From the expression palette: 
f := a /y. Change a and y 

appropriately. Note: to get π, 
type [p][i][ctl][space] and select 

π.

fd t/eKt cos 2 t

t/eKt cos 2 t (2.4.5.1.1)

f 1

eK1 cos 2 (2.4.5.1.2)

f 2 π

eK2 π (2.4.5.1.3)

f 1 C f 2 π

eK1 cos 2 CeK2 π (2.4.5.1.4)

Note that there is also a palette option to make a function of 2 variables f := a, b /z.

Command version 

To get the arrow symbol, type [-][>].

fd t /eKt cos 2 t

t/eKt cos 2 t

f 1

eK1 cos 2

f 1 C f 2 π

eK1 cos 2 CeK2 π

Go back to Table of Contents

2.4.5.2 Converting regular variables and expressions to functions

Sometimes you will have existing expressions assigned to variable names that you want to convert to behave as 
functions. For simple single variable functions, there is a convenient menu option. For example, right clicking on an 
expression gives a menu with an option Conversions → Operator → (variable list).
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(2.4.5.2.1.3)(2.4.5.2.1.3)

(2.4.5.2.1.1)(2.4.5.2.1.1)

(2.4.5.2.1.2)(2.4.5.2.1.2)

First, let's look at some clickable approaches to conversion.  

Operation
Clickable 

First, define the expression 
that we wish to make a 
function. 

Right click and choose
Convert → Operator.

Assign a name f2 using the 
right click menu. Once this is 
done you can now use the new
name f2 as a reusable function.

 eKt cos 2 t Cc

eKt cos 2 t Cc (2.4.5.2.1)
convert to operator

t/eKt cos 2 t Cc (2.4.5.2.2)
assign to a name

t/eKt cos 2 t Cc (2.4.5.2.3)

f2 2

eK2 cos 4 Cc (2.4.5.2.4)

Similarly, you can use the 
same technique to define a 
function of the variable c.

eKt cos 2 t Cc

eKt cos 2 t Cc (2.4.5.2.5)
convert to operator

c1eKt cos 2 t Cc (2.4.5.2.6)
assign to a name

c/eKt cos 2 t Cc (2.4.5.2.7)

f3 2

eKt cos 2 t C2 (2.4.5.2.8)

Command version 

Unfortunately, with the menu option, you can only specify functions of one variable. Furthermore, you have the 
double step of conversion followed by name assignment. A more flexible and convenient approach uses the Maple 
low-level command called unapply( ). 

myexpr d eKt cos 2 t Cc

eKt cos 2 t Cc

newfuncd unapply myexpr, t, c

t, c /eKt cos 2 t Cc

newfunc 1, 3

eK1 cos 2 C3

Go back to Table of Contents

2.4.6 Numerical formats

In the previous example, Maple produced the result of an evaluation as eK1 cos 2 . Why does Maple represent answers in 
a seemingly incomplete way? For example, any calculator could compute eK1 cos 2  as K0.153092. 

Maple can also do this easily but by default it does not for two very important reasons:
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• • 

• • 

(2.4.6.1.5)(2.4.6.1.5)

(2.4.6.1.2)(2.4.6.1.2)

• • 

• • 

(2.4.6.1.3)(2.4.6.1.3)

• • 

(2.4.6.1.1)(2.4.6.1.1)

• • 

(2.4.6.1.4)(2.4.6.1.4)

eK1 cos 2  is mathematically exact whereas K0.153092 is a 6 decimal place approximation to the exact number. With 
an exact representation, you avoid round-off error (not keeping enough decimal places to ensure accuracy) which can be
a major problem for large, complex problems.
eK1 cos 2  preserves some information about the origins of the number and how the value is calculated.

In the above case, both e and cos 2  are both irrational numbers (i.e. cannot be represented by finite or repeating decimal 
numbers). Other  numbers that you could be expressed in an exact Maple answer include:

fractions (e.g. rational finite decimal places like 
1

2
 and rational repeating decimals like 

1

3
)

special numbers like π, and e 
numbers calculated from special functions (e.g. cos(2), Bessel functions, Gamma functions etc.)

irrational numbers like roots (e.g. 2 )

In context of Maple, the opposite of exact numbers is normally referred to as "floating point approximations".

Go back to Table of Contents

2.4.6.1 Converting from exact to decimal representations (floating point)

Consider the expression  

3 e
K

t

6  sin
35  t

6
 35

3
  which is one of the terms to the solution to a linear differential 

equation calculated by Maple (
d2

dt2
y t C

1

3

d

dt
y t Cy t = sin t  with 0 initial conditions). The following shows 

how to convert this expression to floating point.

Operation
Clickable 

Copy or enter the solution 
expression

 

3 e
K

t

6  sin
35  t

6
 35

35

3 e
K

t

6  sin
35  t

6
 35

35

Approximate the exact answer
to 5 decimal places

Right click. Choose Approximate → 5 

 

3 e
K

t

6  sin
35  t

6
 35

35

3 e
K

t

6  sin
35  t

6
 35

35
at 5 digits

0.50709 eK0.16667 t sin 0.98604 t

Calculate for t =
1

3

at 5 digits

0.50709 eK0.16667 t sin 0.98604 t
evaluate at point

0.1548397660
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(2.4.6.1.1.1)(2.4.6.1.1.1)

(2.4.6.1.1.3)(2.4.6.1.1.3)

(2.4.6.2.1.1)(2.4.6.2.1.1)

(2.4.6.1.1.2)(2.4.6.1.1.2)

Command version 

expr d 

3 e
K

t

6  sin
35  t

6
 35

35

3

35
 e
K

1

6
 t
 sin

1

6
 35  t  35

exprfloat d evalf expr, 5

0.50709 eK0.16667 t sin 0.98604 t

eval exprfloat, t =
1

3

0.1548397660

Go back to Table of Contents

2.4.6.2 Enforcing floating point calculations

If you prefer to always see the floating point versions of expressions, you can express numerical values as decimal 
numbers (e.g. from 6 to 6.0. Omitting the 0 and using 6. also works) from the beginning and Maple will carry the 
floating point calculation from that point on.

Operation
Clickable 

For the expression, replace 
numbers with decimal 
equivalents  

3. e
K

t

6.  sin
35.  t

6.
 35.

35.

0.5070925528 eK0.1666666667 t sin 0.9860132974 t (2.4.6.2.1)

Command version 

expr d 

3. e
K

t

6.  sin
35.  t

6.
 35.

35.

exprd 0.5070925528 eK0.1666666667 t sin 0.9860132974 t

Go back to Table of Contents

2.4.7 Plotting 

2.4.7.1 Basic 2D plots of math functions f t
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(2.4.7.1.1.1)(2.4.7.1.1.1)

Plot  f t = 3 e
K

t

6  sin
t

6
. One of the easiest ways is to use the Plot Builder from the right-click menu. The Plot 

Builder offers handy dialog boxes to guide you through the many plotting options.

Operation
Clickable 

Right-click on expression, choose
Plots → Plot Builder. In the dialog 
box, change the plot range to 0 to 50 
(default is -10 to 10).

3 e
K

t

6  sin
t

6

3 e
K

t

6  sin
t

6
(2.4.7.1.1)

/

t

10 20 30 40 50
0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.9

Command version 

expr d 3 e
K

t

6  sin
t

6

3 e
K

1

6
 t
 sin

1

6
 t

plot expr, t = 0 ..50
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(2.4.7.2.3)(2.4.7.2.3)

(2.4.7.2.1)(2.4.7.2.1)

(2.4.7.2.2)(2.4.7.2.2)

t

10 20 30 40 50
0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.9

Go back to Table of Contents

2.4.7.2 Parametric (phase plane) plots x t , y t

Plotting parametrically defined curve x t , y t  (i.e. the coordinates are defined as a function of a common 

parameter) is very similar. For example, define the x coordinate as x t = 3 e
K

t

6  sin
t

6
 and the y coordinate 

y t =
d

dt
x t . Now plot x t  vs. y t  as t varies from 0 to 50.

Operation
Clickable 

Right-click on expression, and 
differentiate with respect to t.

Copy and past both the 
function and derivative and 
place in new line separated by 
a comma.

Mouse on the two functions, 
choose Plots → Plot Builder. 
In the dialog box, change the 
plot range to 0 to 50 (default is 
-10 to 10).

Under Select Plot choose 2D 
Parametric Plot.For the range, 
choose 0 to 50.

3 e
K

t

6  sin
t

6

3 e
K

t

6  sin
t

6
differentiate w.r.t. t

K

e
K

t

6  sin
t

6

2
C

e
K

t

6  cos
t

6

2

3 e
K

t

6  sin
t

6
, K

e
K

t

6  sin
t

6

2
C

e
K

t

6  cos
t

6

2

/
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(2.4.7.2.1.2)(2.4.7.2.1.2)

(2.4.7.2.1.1)(2.4.7.2.1.1)

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9

K0.1

0.1

0.2

0.3

0.4

0.5

Command version 

expr d 3 e
K

t

6  sin
t

6

3 e
K

1

6
 t
 sin

1

6
 t

dexpr d diff expr, t

K
1

2
 e
K

1

6
 t
 sin

1

6
 t C

1

2
 e
K

1

6
 t
 cos

1

6
 t

plot expr, dexpr, t = 0 ..50
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0.1 0.3 0.5 0.7 0.9

K0.1

0.1

0.2

0.3

0.4

0.5

Go back to Table of Contents

2.4.7.3 Plotting Data

Maple can plot data from point-lists that you type in or from files. Maple is smart enough to interpret various data 
formats. Here are some very easy options.

Operation
Clickable 

Option 1: Enter the data yourself 
into Maple.

Open the Matrix palette on the left. 
Press Choose and with the mouse 
pressed, drag and select 2 columns and
as many rows as you have data points. 
Press Insert Matrix.

Replace each element with your data. 
First column will be x values and 
second will be y values. The tab key 
will hop from one element to the next.

Right click on finished matrix and 
select Plots → Plot Builder. 2D Point 
plot will be the only option available.

m
1, 1

m
1, 2

m
2, 1

m
2, 2

m
3, 1

m
3, 2

m
4, 1

m
4, 2

 will be displayed when you insert the matrix. Now 

highlight first element, make change then tab to next element.

K1 5

0 6

2 K2

1

2
3.2

/
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(2.4.7.3.1)(2.4.7.3.1)

K1 0 1 2

K2

K1

1

2

3

4

5

6

Option 2: Easy way of getting data 
in from Excel.

Enter your data into Excel with x 
values in one column and y values in 
the next column.

Highlight the desired data and Copy.

In Maple, Paste into a math area and 
follow the same procedure as above.

-1 5

0 6

2 -2

0.5 3.2

K1 5

0 6

2 K2

0.5 3.2

/

K1 0 1 2

K2

K1

1

2

3

4

5

6
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(2.4.7.3.1.1)(2.4.7.3.1.1)

Command version 

Although there are various Maple datastructures for matrices, it is still easiest to use the Matrix palette even when 
working with commands. 

datamatrixd

K1 5

0 6

2 K2

1

2
3.2

K1 5

0 6

2 K2

1

2
3.2

plot datamatrix, style = point, color = black

K1 0 1 2

K2

K1

1

2

3

4

5

6

Go back to Table of Contents

2.4.7.4 Logarithmic plots 

Within the Plot Builder, you can specify logarithmic axes under Options, then Axes→Advanced Options, and choosing
Log option. 
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(2.4.7.4.1)(2.4.7.4.1)

For example given the following, expression, the Plot Builder gives the gives the associated graph.

exprd
1

1 C0.04 π2
 f2

C
0.4 π

2
 f2

1 C0.04 π2
 f2

2

C
3.24 π

2
 f2

1 C0.04 π
2
 f2

2

1

1 C0.04 π
2
 f2

C
0.4 π

2
 f2

1 C0.04 π
2
 f2

2

C
3.24 π

2
 f2

1 C0.04 π2
 f2

2

/

f

0.01 0.05 0.1 0.5 1 5 10

2

3

4

5

6

7

8

9

Notice that for the lower values of f, the graph lacks detail and it appears to be undersampled. For many engineering 
applications requiring log axes, this is not quite good enough. The other, and better, option is to directly call the
semilogplot call from the plots package. this routine has a smarter sampling routine that adds the appropriate levels of 
detail at the lower values.

plots semilogplot expr, f = 0.01 .. 10
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f

0.01 0.05 0.1 0.5 1 5 10

2

3

4

5

6

7

8

9

The semilogplot command has the log axis on the horizontal. The logplot command has the log scale on the vertical 
axis. The loglogplot command has the log plot on both axes.

Go back to Table of Contents

2.4.8 Basic differential and integral calculus

2.4.8.1 Limits, differentiation, integrals, series

Operation
Clickable  

Differentiation e.g. 
d

d x
 x2 KxC2

3

4 : 

select from the Expression Palette [ 
d

d x
f  ]. 

Highlight the f and enter the expression. See
Entering Maple expressions on how to do 
this. Press enter.

Alternatively, you could just enter the 
expression, then right click on the first 
expression result and choose Differentiate →
x.

d

d x
 x2 KxC2

3

4

3

4
 

2 xK1

x2 KxC2 1/4

Indefinite integration e.g. 

xCsec2 π x  dx: Select [ f dx ] and 

replace f with the expression. Press return.

Alternatively, you could just enter the 
expression (the integrand) and choose
Integrate → x.

Note that Maple does not return a constant C 
as this constant is completely arbitrary and 

xCsec2 π x  dx

1

2
 x2 C

sin π x

π cos π x
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(2.4.8.1.6)(2.4.8.1.6)

(2.4.8.1.1.1)(2.4.8.1.1.1)

(2.4.8.1.5)(2.4.8.1.5)

(2.4.8.1.3)(2.4.8.1.3)
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(2.4.8.1.7)(2.4.8.1.7)

Maple automatically makes the assumption 
that C = 0. 

Definite integration e.g. 

0

π

8

sin5 2 x  cos 2 x  dx: Select [ 
a

b

f dx ] 

and make appropriate substitutions and press
return.

Note that there is no menu-based alternative.

To get a floating point (decimal) 
representation of the answer, right-click and 
choose Approximate → 5.

0

π

8

sin5 2 x  cos 2 x  dx

1

96
at 5 digits

0.010417

Limits e.g. lim
x/N

3 xC5

6 xK8
 : Select [ lim

x/ a
f ] 

and make appropriate substitutions and press
return. You can get the N from the Common 
Symbols palette.

There is a possible menu-based through the
Constructions option but this will generate 
additional steps and is much more 
cumbersome than using the palette.

lim
x/N

3 xC5

6 xK8

1

2

Taylor series e.g. expand 1 Cx  to 8 terms 
about the point x = 0.

There is no convenient clickable method. 
This example shows how you can construct 
the Taylor series using the fundamental 

definition, >
n = 0

N
xKa n f n a

n !
 where f n  

is the nth derivative with respect to x. Note 
that Maple also understands this notation.

You will need to define a function f which 
can be conveniently differentiated and 
evaluated at the value x = a in the numerator.
 The interpretation of the odd looking factor 

in the numerator is "evaluate the nth 

derivative of the function 1 Cx  at x = 0.

fd x/ 1 Cx

x/ xC1

>
n = 0

7
xK0 n  f n x

x = 0

  

n !

1 C
1

2
 xK

1

8
 x2 C

1

16
 x3 K

5

128
 x4 C

7

256
 x5

K
21

1024
 x6 C

33

2048
 x7

Command version 

Differentiation

diff x2 KxC2

3

4 , x

3

4
 

2 xK1

x2 KxC2 1/4

Indefinite integration

int xCsec2 π x , x
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(2.4.8.2.1)(2.4.8.2.1)

(2.4.8.2.2)(2.4.8.2.2)

(2.4.8.1.1.2)(2.4.8.1.1.2)

(2.4.8.1.1.6)(2.4.8.1.1.6)

(2.4.8.1.1.3)(2.4.8.1.1.3)

1

2
 x2 C

sin π x

π cos π x

Definite integration

myintd int sin5 2 x  cos 2 x , x = 0 ..
π

8

1

96

evalf myint, 5

0.010417

Limits

lim
3 xC5

6 xK8
, x =N

lim
3 xC5

6 xK8
, x = N

Taylor Series

taylor 1 Cx , x = 0, 8

1 C
1

2
 xK

1

8
 x2 C

1

16
 x3 K

5

128
 x4 C

7

256
 x5 K

21

1024
 x6 C

33

2048
 x7 CO x8

Unlike the manual approach in the previous example, Maple automatically adds a O x8  term indicating the order 
of the expansion.

Go back to Table of Contents

2.4.8.2 Ordinary differential equations

Operation
Clickable  

ODE with initial conditions e.g. 

d2y

dt2
C

dy

dt
Cy = sin t .

First, enter the DE. For the second derivative, 

you need to use the palette symbol [ 
d

d x
f ] 

twice in a nested fashion. Insert the symbol 
once. Change the x to a t then tab to highlight 
the f. Now, instead of typing something in, 

press on the [ 
d

d x
f ] symbol again.  Change 

the x, then replace the f with y t .

NOTE: It is very important that you specify
the main variable as a function of t: i.e. y t  
instead of just y. 

Now, to solve the DE, right-click and choose
Solve DE → y t . A general solution is then 
returned. Note that the solution includes 
undetermined constants _C1 and _C2. This is 
because we have not specified initial 

d

d t
 

d

d t
 y t C

d

d t
 y t Cy t = sin t

d2

dt2
 y t C

d

dt
 y t Cy t = sin t

solve DE

y t = e
K

1

2
 t
 sin

1

2
 3  t  _C2

Ce
K

1

2
 t
 cos

1

2
 3  t  _C1Kcos t
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(2.4.8.2.1.3)(2.4.8.2.1.3)

(2.4.8.2.1.1)(2.4.8.2.1.1)

(2.4.8.2.1.2)(2.4.8.2.1.2)

conditions.

Try the same process again but this time, 
append the initial conditions (i.e. separated by 
a comma). Carefully note the notation for the 
derivative condition D y 0 . Make sure 
there are no spaces.

Now when you solve, you get a more precise 
solution.

Also note that the solution is returned as a 
mathematical equation. i.e. 
y t = solution expression. To do anything 
with the solution, it is helpful to extract only 
the expression portion of the equation -- that 
is, the right hand side.

Using the right-click menu, choose Right-hand
side. Now it returns the expression.

In this example, use the Plot Builder with t 
from 0 to 10 to see what the solution looks 
like.

d

d t
 

d

d t
 y t C

d

d t
 y t Cy t = sin t , y 0 = 0,

 D y 0
solve DE

y t =
1

3
 e
K

1

2
 t
 sin

1

2
 3  t  3

Ce
K

1

2
 t
 cos

1

2
 3  t Kcos t

right hand side

1

3
 e
K

1

2
 t
 sin

1

2
 3  t  3 Ce

K
1

2
 t
 cos

1

2
 3  t

Kcos t

/

t

2 4 6 8 10

K0.8

K0.6

K0.4

K0.2

0

0.2

0.4

0.6

0.8

1

Command version 

de d diff y t , t, t Cdiff y t , t Cy t = sin t

d2

dt2
 y t C

d

dt
 y t Cy t = sin t

dsolve de

y t = e
K

1

2
 t
 sin

1

2
 3  t  _C2Ce

K
1

2
 t
 cos

1

2
 3  t  _C1Kcos t

Now, with initial conditions

sold dsolve de, y 0 = 0, D y 0

y t =
1

3
 e
K

1

2
 t
 sin

1

2
 3  t  3 Ce

K
1

2
 t
 cos

1

2
 3  t Kcos t

solrd rhs sol
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(2.4.8.2.1.4)(2.4.8.2.1.4)

(2.4.8.3.4)(2.4.8.3.4)

(2.4.8.3.1)(2.4.8.3.1)
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(2.4.8.3.5)(2.4.8.3.5)

(2.4.8.3.2)(2.4.8.3.2)

1

3
 e
K

1

2
 t
 sin

1

2
 3  t  3 Ce

K
1

2
 t
 cos

1

2
 3  t Kcos t

plot solr, t = 0 ..10

t

2 4 6 8 10

K0.8

K0.6

K0.4

K0.2

0

0.2

0.4

0.6

0.8

1

Go back to Table of Contents

2.4.8.3 Systems of ODEs 

Consider two coupled second order ODEs. 
dx

1
2

dt2
= x

2
K2 x

1
 and 

dx
2
2

dt2
= x

1
K2 x

2
. First specify the differential 

equations.
de1d diff x

1
t , t, t = x

2
t K2 x

1
t

d2

dt2
 x

1
t = x

2
t K2 x

1
t

de2d diff x
2

t , t, t = x
1

t K2 x
2

t

d2

dt2
 x

2
t = x

1
t K2 x

2
t

Now collect the equations and the conditions into a list and use dsolve to solve. Maple returns a solution set with 2 
distinct solutions x

1
t  and x

2
t . Assign the solution set to the variable sol so that it is easy to extract the desired 

solution and the expression.

sold dsolve de1, de2, x
1

0 = 1, x
2

0 = 0, D x
1

0 = 0, D x
2

0 = 0

x
1

t =
1

2
 cos 3  t C

1

2
 cos t , x

2
t = K

1

2
 cos 3  t C

1

2
 cos t

sol 1

x
1

t =
1

2
 cos 3  t C

1

2
 cos t

rhs sol 1

1

2
 cos 3  t C

1

2
 cos t

Go back to Table of Contents
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(2.4.8.4.3)(2.4.8.4.3)

(2.4.8.4.1)(2.4.8.4.1)

(2.4.8.4.5)(2.4.8.4.5)

(2.4.8.4.2)(2.4.8.4.2)

(2.4.8.4.4)(2.4.8.4.4)

2.4.8.4 Numerical solutions to systems of ODEs 

Using the same example as above, solve the system numerically. As before, make the call to dsolve but this time, 
include the option numeric after the list of equations and conditions. Maple returns a "procedure object". Assign the 
name sol to this object.

de1d diff x
1

t , t, t = x
2

t K2 x
1

t

d2

dt2
 x

1
t = x

2
t K2 x

1
t

de2d diff x
2

t , t, t = x
1

t K2 x
2

t

d2

dt2
 x

2
t = x

1
t K2 x

2
t

sold dsolve de1, de2, x
1

0 = 1, x
2

0 = 0, D x
1

0 = 0, D x
2

0 = 0 , numeric

proc x_rkf45 ... end proc

This is basically a container that has all of the necessary information about the equations and structured in a way that it
can conveniently calculate specific values or plots when needed.  Try calculating the solution values when t = 1. You 
now get the specific values of your main variables and their first derivative.

sol 1

t = 1., x
1

t = 0.189872875706317584,
d

dt
 x

1
t = K1.27552578790124894, x

2
t

= 0.350429433187948669,
d

dt
 x

2
t = 0.434054797638206258

Typically, you would want to see the solution as a graph. There is a special command called odeplot which is 
contained in the plots package (a special collection of useful graphics tools).  First load the package.

with plots

animate, animate3d, animatecurve, arrow, changecoords, complexplot, complexplot3d, conformal,

conformal3d, contourplot, contourplot3d, coordplot, coordplot3d, densityplot, display, dualaxisplot,

fieldplot, fieldplot3d, gradplot, gradplot3d, graphplot3d, implicitplot, implicitplot3d, inequal,

interactive, interactiveparams, intersectplot, listcontplot, listcontplot3d, listdensityplot, listplot,

listplot3d, loglogplot, logplot, matrixplot, multiple, odeplot, pareto, plotcompare, pointplot, pointplot3d,

polarplot, polygonplot, polygonplot3d, polyhedra_supported, polyhedraplot, rootlocus, semilogplot,

setcolors, setoptions, setoptions3d, spacecurve, sparsematrixplot, surfdata, textplot, textplot3d, tubeplot

Now call odeplot and send in the name of the DE solution object. The t range you want to plot (i.e. 0 to 20 here), and to
ensure a smooth plot, specify the number of calculation and plotting points to be 200.  The default plot is the first state 
variable, in this case, x

1
t .

odeplot sol, 0 ..20, numpoints = 200
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t

5 10 15 20

x[1]

K0.8

K0.6

K0.4

K0.2

0

0.2

0.4

0.6

0.8

1

To view x
2

t , enclose the horizontal axis variable t and x
2

t , in a list. Note that you could have specified x
1

t  in 

this way instead of taking the default in the above example step.

odeplot sol, t, x
2

t , 0 ..20, numpoints = 200

t

5 10 15 20

x[2]

K0.8

K0.6

K0.4

K0.2

0

0.2

0.4

0.6

0.8

For many types of ODE systems, it is useful to plot one variable against the other. This is called a phase plane plot. To 
use odeplot to create a phase plane plot, place both variables in the list. Basically, x

1
t , x

2
t  specifies a set of 

coordinates controlled by the parameter t. As t varies, it results in a different value for both x
1
 and x

2
 and consequently, 

this will carve out a pattern.

odeplot sol, x
1

t , x
2

t , 0 ..20, numpoints = 200
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(2.4.9.1.1)(2.4.9.1.1)

x[1]

K0.6 0.2 0.4 0.6 0.8 1

x[2]

K0.8

K0.6

K0.4

K0.2

0.2

0.4

0.6

0.8

Go back to Table of Contents

2.4.9 Matrix operations

2.4.9.1 Defining a matrix or a vector

The easiest way to define a matrix or vector is with the Matrix palette. Using the Choose tool, you can conveniently 
specify arbitrary matrix or vector dimensions. You can even copy table of numbers from Excel and other packages and
paste them as proper Maple matrices.

Operation
Clickable 

E.g. Define a 3 #3 matrix

Open the Matrix palette on the left. Press
Choose and with the mouse pressed, drag 
and select 3 rows and 3 columns. Press
Insert Matrix.

Replace each element with your desired 
values. The tab key will hop from one 
element to the next.

Press return

m
1, 1

m
1, 2

m
1, 3

m
2, 1

m
2, 2

m
2, 3

m
3, 1

m
3, 2

m
3, 3

 will be displayed when you insert the 

matrix. Now highlight first element, make change then tab to next 
element. 

1 5
1

2

2 0 ω
0

2

K1 5 0.72

1 5
1

2

2 0 ω
0

2

K1 5 0.72

Note that Maple accepts a wide range of data types for the 
elements.

E.g. Define a 3 #1 column vector

From Matrix palette, select 3 rows and 
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(2.4.9.1.2)(2.4.9.1.2)

(2.4.9.1.3)(2.4.9.1.3)

(2.4.9.1.1.1)(2.4.9.1.1.1)

one column and proceed as before.

2

K1

π

2

K1

π

E.g. Copy a matrix from Excel

Enter your data into Excel.

Highlight the desired data and Copy.

In Maple, Paste into a math area. The data
will come in as a proper matrix.

Now highlight, copy, and paste into Maple.

-1 5

0 6

2 -2

0.5 3.2

K1 5

0 6

2 K2

0.5 3.2

Command version

Maple also has a low-level datastructure for matrices using a combination of "angle brackets" (i.e. less than "<" or 
greater than ">" symbols) and the vertical bar "|".

mymatrix d 1, 2,K1 5, 0, 5
1

2
, ω

0

2
, 0.72

1 5
1

2

2 0 ω
0

2

K1 5 0.72

Caution: When using this notation, you enter the elements by columns (i.e. each grouping is a column). This is a 
bit tricky as the actual typing appears like a row.

mycolumnvector d 2,K1, π
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2

K1

π

Caution: again, typing a column vector with a command looks like you are defining a row vector. To type a row 
vector, do the following.

myrowvectord 2 K1 π

2 K1 π

Go back to Table of Contents

2.4.9.2 Matrix operations

2.4.9.2.1 Transpose, Determinant, Inverse

Operation
Clickable 

Transpose a matrix

Place cursor to the right of the 
matrix and raise the matrix to the 
power of "T" (i.e. the transpose 
notation). Use the "^" symbol to 
do this.

or.

Right click and choose Standard 
operations → Transpose 

-1 5

0 6

2 -2

0.5 3.2

T

K1 5

0 6

2 K2

0.5 3.2

T

or

-1 5

0 6

2 -2

0.5 3.2

transpose K1 0 2 0.5

5 6 K2 3.2

Inverse of a square matrix

Raise matrix to the power of -1 or 
use right click menu and choose
Standard operations → Inverse 

1 5
1

2

2 0 2

K1 5 7

K1
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(2.4.9.2.1.1.2)(2.4.9.2.1.1.2)
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(2.4.9.2.1.2)(2.4.9.2.1.2)

2

17

13

34
K

2

17

16

85
K

3

34

1

85

K
2

17

2

17

2

17

Try a singular matrix. The linear dependence will cause an error.

1 5
1

2

2 0 2

4 0 4

K1

Error, (in rtable/Power) singular matrix

Determinant of a square matrix

Use the right click menu and 
choose Standard operations →
Determinant. Note that Maple is 
capable of symbolic operations on 
matrices.

sC7 12

K1 s

determinant
s2 C7 sC12

Command version 

mymatrixd

-1 5

0 6

2 -2

0.5 3.2

K1 5

0 6

2 K2

0.5 3.2

LinearAlgebra Transpose mymatrix

K1 0 2 0.5

5 6 K2 3.2

mymatrixd

1 5
1

2

2 0 2

K1 5 7

1 5
1

2

2 0 2

K1 5 7
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LinearAlgebra MatrixInverse mymatrix

2

17

13

34
K

2

17

16

85
K

3

34

1

85

K
2

17

2

17

2

17

mymatrixd
sC7 12

K1 s

sC7 12

K1 s

LinearAlgebra Determinant mymatrix

s2 C7 sC12

Go back to Table of Contents

2.4.9.2.2. Eigenvalues 

The following examples compute the eigenvalues of a 5 #5 matrix  

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

 in two 

different ways.

Operation
Clickable 

Right click menu Eigenvalues, 
etc. → Eigenvalues.

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

eigenvalues

K0.637107916517966388C0.666879401766211300 I

K0.637107916517966388K0.666879401766211300 I

4.77821069300950660 10-16C0. I

K0.507486110589103756C0. I

K0.968298056374965800C0. I

Note, the last three are real eigenvalues as the imaginary portion is 0. If
you were to interpret this result, you would typically omit the C0. I. 
The next example shows an alternate method.

Compute the eigenvalues by 
calculating the roots of the 
characteristic equation.
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Choose Characteristic Polynomial 
from Eigenvalue menu.

Right click on result and choose
Solve→Solve

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

characteristic polynomial

1.88150 λ
2
C3.2225 λ

3
C2.75 λ

4
C0.41800 λCλ

5 solve
λ = 0. ,

λ = K0.6371079165C0.6668794018 I , λ

= K0.5074861106 , λ = K0.9682980564 , λ

= K0.6371079165K0.6668794018 I

Command version 

 mymatrixd

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

 
LinearAlgebra Eigenvalues mymatrix

K0.637107916517966388C0.666879401766211300 I

K0.637107916517966388K0.666879401766211300 I

4.77821069300950660 10-16C0. I

K0.507486110589103756C0. I

K0.968298056374965800C0. I

 mymatrixd

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

0 2 0 0 0

K0.1 K0.35 0.1 0.1 0.75

0 0 0 2 0

0.4 0.4 K0.4 K1.4 0

0 K0.03 0 0 K1

cpoly d LinearAlgebra CharacteristicPolynomial mymatrix, λ

1.88150 λ2
C3.2225 λ3

C2.75 λ4
C0.41800 λCλ5

solve cpoly

0., K0.6371079165C0.6668794018 I, K0.5074861106, K0.9682980564, K0.6371079165
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K0.6668794018 I

Go back to Table of Contents

2.4.9.2.3 Multiplication and matrix expressions

Operation
Clickable 

Scalar multiplication

s I for a 2 #2. If you are using the 
Matrix palette, you can either enter a 
generic matrix and replace the elements 
with 1s and 0s or you can explicitly 
enter an identity matrix with Type →
Identity.

s 
1 0

0 1

s 0

0 s
(2.4.9.2.3.1)

Matrix multiplication

To multiply a matrix and a vector, 
simply place the two objects side by 
side and Maple will properly interpret 
the multiplication and apply the proper 
rules.

If you try the vector in the wrong form. 
Maple checks for dimension consistency
and generates an error.

0 1

ω
0

2
0

x
1

x
2

x
2

ω
0

2
 x

1

(2.4.9.2.3.2)

0 1

ω
0

2
0

x
2
ω

0

2
 x

1

Error, (in LinearAlgebra:-

MatrixVectorMultiply) invalid input: 

LinearAlgebra:-MatrixVectorMultiply 

expects its 2nd argument, v, to be of 

type Vector[column] but received Vector

[row](2, {(1) = x[2], (2) = omega[0]^2*

x[1]})

Complex example

det  sIKKKK FKKKKGK  .

where I is the identity matrix, and F, G, 
and K correspond to those specified in 
the example on the right.

Most of the computation can be done 
exactly as you would write the formula 
except for the determinant. This is done 
through the right-click menu, Standard 
operations →Determinant.

 s 
1 0

0 1
 K 

0 1

ω
0

2
0

K
0

1
K

1
K

2

s K1

Kω
0

2
CK

1
sCK

2

(2.4.9.2.3.3)

determinant

s2 Cs K
2
Kω

0

2
CK

1
(2.4.9.2.3.4)
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Command version 

myidentity d 
1 0

0 1

1 0

0 1

LinearAlgebra ScalarMultiply myidentity, s

s 0

0 s

or

s myidentity

s 0

0 s

mymatrixd

0 1

ω
0

2
0

0 1

ω
0

2
0

myvectord

x
1

x
2

x
1

x
2

LinearAlgebra Multiply mymatrix, myvector

x
2

ω
0

2
 x

1

You can also use the matrix "dot" operator (the "period" dot) which knows the special rules of matrix and 
vector multiplication. This should not be confused with the dot product (i.e. scalar product).

mymatrix.myvector

x
2

ω
0

2
 x

1

For multiplying 2 proper matrices, use the dot operator or the LinearAlgebra MatrixMultiply M1, M2  
command.

Fmatrixd

0 1

ω
0

2
0

0 1

ω
0

2
0
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• • 

(2.4.9.2.3.1.12)(2.4.9.2.3.1.12)

(2.4.9.2.3.1.11)(2.4.9.2.3.1.11)

(2.4.9.2.3.1.9)(2.4.9.2.3.1.9)

• • 

• • 

(2.5.1)(2.5.1)

Gvectord
0

1

0

1

Kvectord K
1

K
2

K
1

K
2

with LinearAlgebra :

Determinant  Multiply s, IdentityMatrix 2 K FmatrixKMultiply Gvector, Kvector

s2 Cs K
2
Kω

0

2
CK

1

or

Determinant s.IdentityMatrix 2 K FmatrixKGvector.Kvector

s2 Cs K
2
Kω

0

2
CK

1
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2.5 Dynamic systems package (control theory package)

Maple has a built-in package of various useful tools for control theory and linear systems concepts. It is called the
DynamicSystems package and it can be loaded by typing in

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable, PhaseMargin,

PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable, SSModelReduction,

SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System, SystemOptions, ToDiscrete,

TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

The list of commands this returns are the various functions in the package. You can now refer to these commands simply 
through the command name. An alternative is the "long form" where you define the full function path. For example for the 
command BodePlot, the long form is 

DynamicSystems BodePlot

If you refer to the command this way, you do not need to invoke the with DynamicSystems  as before. The long form is useful
if you want to do a quick one shot call and you want to guarantee that the function can be found by Maple. In these notes, you 
will see examples of both short and long form. The long form will always be in the form of,

Package name  command name 

The following are the long form name list of the most important commands in the DynamicSystems package. Names are 
hyperlinked to their respective help pages.

System definitions

DynamicSystems[NewSystem] : create a system object compatible with the DynamicSystems package

DynamicSystems[PrintSystem] : print the content of a system object

Responses and plots

DynamicSystems[BodePlot]        : plot magnitude and phase versus frequency
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DynamicSystems[ImpulseResponsePlot] : plot the impulse response of a system

DynamicSystems[MagnitudePlot]   : plot log magnitude versus frequency

DynamicSystems[PhasePlot]       : plot phase versus frequency

DynamicSystems[ResponsePlot]    : plot response of a system to a given input

DynamicSystems[RootLocusPlot]   : generate a root-locus plot

System calculations

DynamicSystems[CharacteristicPolynomial] : compute the characteristic polynomial of a state-space system

DynamicSystems[ControllabilityMatrix] : compute the controllability matrix

DynamicSystems[GainMargin] : compute the gain-margin and phase-crossover frequency

DynamicSystems[ObservabilityMatrix] : compute the observability matrix

DynamicSystems[PhaseMargin] : return the phase-margin and gain-crossover frequency

DynamicSystems[RouthTable] : generate the Routh table of a polynomial

Go back to Table of Contents

2.6 Simple programming in Maple

Most of this guide provides interactive (clickable) approaches to problem-solving. With most, you will also see the command 
equivalent. The command set that you use here is actually part of a complete programming language called the Maple 
language. In fact, if you read older references to Maple or speak to someone who has used the system for years, they often 
refer to Maple as a mathematical language rather than an integrated application.

Once you have become proficient in basic programming, you will be able to apply the underlying power of Maple to a wide 
variety of engineering and scientific problems. You can even use Maple to develop complete applications.

Go back to Table of Contents

2.6.1 Basic architecture
The Maple system is organized in a way that math computations are very fast, easy to program, and can run on a wide 
range of different operating systems. The three most important parts of the system are,

The Maple Kernel: as the "heart" of the system, this portion is relatively small in size and is written in C or C++. 
Because it is compiled, speed is very fast and consequently, all of Maple's low-level operations or anything that needs 
maximum speed is taken care of by the kernel. Additionally, the kernel understands the Maple programming language --
i.e. the kernel has a language "interpreter".

The Maple Library: as the "brains" of the system, this portion is the largest portion and is written in the Maple language.
The Maple language is optimized for math-oriented code so it takes care of many of the details that general languages 
such as Java or C require. As a result coding time is much shorter. Furthermore, because it is an interpreted language (as
opposed to compiled), debugging and "quick and dirty" programs are much easier to write. When most users program in
the Maple system, they are essentially talking about writing additional Maple code to supplement the built-in routines of
the library.

The User Interface: as the "face" of the system, this portion is written in the Java to facilitate the graphical interactions. 
In more recent versions (since Maple 10), it has been possible to customize the UI with relatively simple programming.
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The fact that most of the math knowledge in Maple is in the Library and written in a user-friendly language (Maple), with 
a very modest programming effort, means that you can perform computing tasks that would take days to program in a 
conventional language.

Go back to Table of Contents

2.6.2 Programming approach

Programming in Maple can mean anything from writing a group of command lines and executing them. The various 
examples in this guide that use commands instead of clickable approaches are intended  to be executed one command at a 
time: i.e. type a command, press enter, see result, repeat for the next command, repeat etc.  The following example shows 
how you can develop this basic idea to more useful reusable tools using some very simple Maple techniques.

2.6.2.1 First step: solve problem interactively

For example, consider the following steps for the computation of the characteristic equation for a closed loop transfer 
function.

Gd
1

s2 C2 sK1

1

s2 C2 sK1

Hd
1

sC1

1

sC1

TFd normal
G H

1 CG H

1

s s2 C3 sC1

chareqd denom TF

s s2 C3 sC1
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2.6.2.2 Variation 1: enter same commands in a single block

For this next step, let's re-enter the above commands but this time instead of pressing [Enter] with each line, you 
press [Shift][Enter] simultaneously. Doing this will suppress execution and let you enter a block of commands. Also,
insert a semicolon ";" after each command including the last command. This logically separates the lines so that 
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Maple knows they are distinct commands and not something that is a continuation. Once complete, press enter and all 
of the commands will then execute.

Gd
1

s2 C2 sK1
;

 Hd
1

sC1
;

 TFd normal
G H

1 CG H
;

 chareq d denom TF ;

1

s2 C2 sK1

1

sC1

1

s s2 C3 sC1

s s2 C3 sC1

The output shows the result of each step and therefore, the last line of the output group is the characteristic equation. 

The above is a very simple Maple "program". If you simply went back and edited G or H for other functions, with a 
simple press of the [Enter] key you can get the new characteristic equation. Also note that the variable chareq now 
contains the characteristic equation and can be used in other calculations.

Go back to Table of Contents

2.6.2.3 Variation 2: compose a function

The previous simple "program" can be improved by using the function or operator notation that was introduced in
Defining Functions f x .

getchareqd G, H /denom  normal
G H

1 CG H
 

G, H /denom normal
G H

1 CG H

getchareq
1

s2 C2 sK1
, 

1

sC1

s s2 C3 sC1

getchareq
sC1

s2 C sK1
, K

p

s2 CsK1 CK
p
 sCK

p

This is a much more elegant and convenient form. Now you can simply call this new function with a single new 
command. The problem with this approach is, of course, if the steps become greater in number or complexity, the 
single-line functional programming becomes a real challenge.

Go back to Table of Contents

2.6.2.4 Variation 3: create a procedure 

The most popular form for a Maple program is typically in the form of a procedure which is the official name of 
Maple's subroutine. For example enter the following using [Shift][Enter] for each line,
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getchareqprocdproc G, H

     TFd normal
G H

1 CG H
;

     denom TF ;
 end proc;

Warning, `TF` is implicitly declared local to procedure 

`getchareqproc`

proc G, H local TF; TF := normal G * H / 1 CG * H ; denom TF end proc

getchareqproc
1

s2 C2 sK1
, 

1

sC1

s s2 C3 sC1

The result returned by a procedure is generally the output of the last command executed -- in this case, the command 
denom TF . Also note that it warns of the local nature of the variable TF. Maple procedures assume all subroutine 
variables are local unless specified otherwise. The procedure is very similar in structure and style with subroutines 
from other languages. More experienced programmers can add more sophistication simply by adding lines of code.
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2.6.2.5 Variation 4: loops and conditions

Let's consider a more complex procedure that will accommodate an arbitrary number of functions and use the formula 
G

1
G

2
...G

n

1 CG
1
G

2
...G

n

 to compute the transfer function and check for the degree of the characteristic equation and print a 

message if the degree is greater than 3 (why do you think it is important for us to know is a degree of a polynomial is 
greater than 3?).

getchareqproc2dproc Glist, n
  
 local Gprod, i, TF, ceq, ceqdeg;

    

 # set product variable to 1. Loop through all functions and compute product
    Gprodd 1;
     for i from 1 to n do
         Gprodd Gprod$Glist i ;
     end do;
   
 # get characteristic equation  

     TFd normal
Gprod

1 CGprod
;

     ceqd denom TF ;
 
 # get the degree of the characterisic equation    
     ceqdegd degree ceq ;
 
 # check the degree. If O 3 return short message, the degree, the equation, otherwise, return just the equation    
     if ceqdegO3  then
          "Attention ... degree is", ceqdeg, ceq
     else
          ceq;
     end if;
 
 end proc;

proc Glist, n

local Gprod, i, TF, ceq, ceqdeg;

Gprod := 1;
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for i to n do Gprod := Gprod * Glist i end do;

TF := normal Gprod / GprodC1 ;

ceq := denom TF ;

ceqdeg := degree ceq ;

if 3 !ceqdeg then "Attention ... degree is", ceqdeg, ceq else ceq end if

end proc

getchareqproc2
1

s
,

1

sK1
,

1

3
,

2

sC2
, 4

2 C3 s3 C3 s2 K6 s

getchareqproc2
1

s
,

1

s2 CsK1
,

K

s
, 3

"Attention ... degree is", 4, KCs4 Cs3 Ks2

Notes on the above enhanced procedure:

The syntax for the for loop is 
for index variable from start value to final value do
         steps of the loop ...
end do;

The syntax for the conditional branch is, 
if condition test  then
          first possible result
 else
          other possible result
 end if;

The functions were collected as single list (i.e. a group contained in square brackets) that was named Glist within the 
procedure. This way, the procedure has a single name for the whole collection and can simply use an index to access 
individual functions.

All local variables were declared as such.

The Maple comment character is #

The output line "Attention ... degree is", ceqdeg, ceq within the if structure is a crude way of stringing together the 
pieces for the message. There are, of course, more polished ways of printing messages and returning results.

Go back to Table of Contents

2.6.2.6 Variation 5: error trapping

This version introduces a very convenient command nops which returns the "number of operands". So in this case, the 
procedure uses nops to count the number of function in the incoming list instead of requiring the user to explicitly 
specify the number.

It also introduces the error command which, when used with the if, gives a convenient way to introduce error trapping 
and friendly messages. In this case, the procedure checks for a valid number of functions within the list and exits the 
procedure if the user has left the list blank.

getchareqproc3dproc Glist
  
 local n, Gprod, i, TF, ceq, ceqdeg;
  
 # get number of functions in the list
 
     n d nops Glist ;
     if  n ! 1 then error "Please enter at least one function" end if;
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 # set product variable to 1. Loop through all functions and compute product
    Gprodd 1;
     for i from 1 to n do
         Gprodd Gprod$Glist i ;
     end do;
   
 # get characteristic equation  

     TFd normal
Gprod

1 CGprod
;

     ceqd denom TF ;
 
 # get the degree of the characterisic equation    
     ceqdegd degree ceq ;
 
 # check the degree. If O 3 return short message, the degree, the equation, otherwise, return just the equation    
     if ceqdegO3  then
          "Attention ... degree is", ceqdeg, ceq
     else
          ceq;
     end if;
 
 end proc;

proc Glist

local n, Gprod, i, TF, ceq, ceqdeg;

n := nops Glist ;

if n !1 then error "Please enter at least one function" end if;

Gprod := 1;

for i to n do Gprod := Gprod * Glist i end do;

TF := normal Gprod / 1 CGprod ;

ceq := denom TF ;

ceqdeg := degree ceq ;

if 3 !ceqdeg then "Attention ... degree is", ceqdeg, ceq else ceq end if

end proc

getchareqproc3
1

s
,

1

sK1
,

1

3
,

2

sC2

3 s3 C3 s2 K6 sC2

getchareqproc3

Error, (in getchareqproc3) Please enter at least one function
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2.7 Maple Gotchas -- DON'T FORGET!

Maple is used by hundreds of thousands of people and many different fields. As such, it has aspects that may make perfect 
sense for one type of user but seem very odd to another. The following are some fundamental elements of Maple that many 
new users often trip up with. For now, simply familiarize yourself with these tips and tricks and you will encounter many 
fewer issues as you develop your Maple proficiency.

RULE NUMBER ONE: Maple is not human!

Yes it may seem intelligent because it can produce answers to math problems that would take you days to solve but remember 
that Maple is still basically software that follows digital recipes and algorithms to produce the answers. In some cases, it 
cannot find an answer to a problem but perhaps with your human insight you can immediately deduce it; or maybe it orders the
terms of a polynomial differently than you normally would. In either case, it is not the most productive use of your time to 
fight with the software so that it is visually more to your liking or trying to force it to deal with mathematical operations that it 
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has not been programmed to do (yet). Once you accept the deterministic and finite nature of this software, you will quickly 
identify all of good applications for it and find quick and easy ways to work around the rough parts.

Maple is case sensitive

Maple cares about the difference between myvariable and Myvariable. When following the examples in this guide make sure 
you replicate the steps faithfully.

Don't forget to Restart

If you are doing a lot of little tasks in a given Maple session (for example, working through various examples in these notes), 
you should get in the habit of forcing a memory-clear or "restart" which clears all of your variable definitions. For instance, if 

you defined a variable a to have some value like 
1

3
 in a previous calculation and later you want to specify a general expression

a2 C1 but you want a to be an unknown, you may end up in a state where you are not quite sure what all the values are. So, if 

you are at the very beginning of a problem, clearing memory is a good idea. To restart, either press  in the main toolbar 

or if you are using commands, type restart.

Assignments (dddd ) vs. equalities ( = )

Assignments are used to give variable names to expressions. So, f d sin x  reads as, "let the variable name f represent the 
expression sin x .  The equal sign without the colon is considered a statement mathematical equality. So, f = sin x  reads as 
"the mathematical quantity f is equal to sin x . The equal sign is typically used in logical comparisons ("if then else" or other 
Boolean comparisons -- equivalent to the double equal operator == in the C language) or in composing actual mathematical 

equations. In Maple, it is valid to state fd sin x =
1

y
 which reads "let the variable name f represent the implicit equation 

sin x =
1

y
.

Variables ( f ) vs. functions ( f x  )

In Maple, if you define a standard variable (e.g. fd sin x ), you cannot immediately use that variable name for function 

evaluations f x  (e.g. to calculate sin 2.5 , sin
π

2
, etc.). Maple does provide several convenient ways to work with 

functions. Examples are shown in the section Defining Functions.

Showing multiplications

In the regular formatted math display mode, multiplication can be specified in one of two ways:
explicitly type a * character (star). The expression will then show a centered dot to denote multiplication (e.g. typing 2*k/3 

will give 
2$k

3
).

use a space to imply multiplication. This is closer to what you would typically do if you were to write mathematical 
expressions by hand. In this case, no center dot will appear and multiplication is implied by the juxtaposition (e.g. type 2 

[space] k/3 will give 
2 k

3
).

The first option is unambiguous and is preferred by many users. This guide tends to use the second way because math becomes
more intuitive for reading and once you get used to it, it is the fastest way to enter formulas. At the outset though, you should 
take extra care in "seeing" the spaces. For example k x (i.e. k [space] x) is k multiplied by x. If you omit the space, you will get 
kx which Maple interprets as a single variable with the name kx. Also, if you have x t , Maple will interpret this as "x as a 
function of t" and not "x times t". Conversely, if you include a space in a function name (e.g. f [space] (t) or f t ), Maple will 
not see a function but f times t.

This may seem complicated but you get used to it very quickly. If you find yourself not getting used to it soon enough, feel 
free to use the * notation and any of the examples.

Number formats: fractions vs. decimal numbers
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Maple, by default, expresses numerical answers in terms of fractions and irrational numbers (e.g. π, 2 , etc.). This ensures 

that no roundoff errors are generated (e.g. 
1

3
 is exact but the floating point equivalent 0.33333 ... will always be an 

approximation of 
1

3
 regardless of the number of digits you carry. In Maple, you can conveniently switch from exact to 

floating point. Details are in the section Numerical Formats.

Indexed or subscripted variables

To some, the variables K
p
, K

i
, and K are three different variables. To Maple, this is actually tricky situation. Two of the three 

have subscripts or an index while the last is just plain K. This can cause confusion as subscripted variable in Maple behave 
differently than unsubscripted variables. The preferred situation for Maple is if all were subscripted or none were subscripted. 
For example using variables K

p
, K

i
, and K

0
 is fine or removing the subscripts altogether and using Kp, Ki, and K are both fine.

Semicolons and colons

Older versions of Maple (i.e. before Maple 10) enforced either a semicolon ( ; ) or colon( : ) at the end of every line if you are 
using commands. With newer versions, when you are working in the normal "document" mode, there is no need. The only 
exception is when you program and you need to group lines of code together, the semicolon or colon are critical. Most 
exercises in this guide omit these characters with the exception of those illustrating programming techniques. If you are using 
these characters, the semicolon assumes you want to see the output and the colon suppresses output.

Packages and the with command

Not all Maple commands are actually available to you at startup. There is a fairly important and large collections of commands
contained in something called a Maple "package". Examples of important packages are LinearAlgebra (linear algebra and 
matrix operations), inttrans (integral transforms including Laplace transforms), plots (special plotting routines), and
DynamicSystems (special functions for engineering modeling including control systems). They are included with the software 
but must be "loaded" into the Maple session. There are two common ways to do this.

The "long form" combines both the package name and the individual command in the form package name[command] (no 
space). For example inttrans laplace  is the long form for the Laplace transform command. You would need to specify the 
long form every time you access the command.

The second way is using the with command in the form with(package name) before you execute any of the commands. This 
approach loads all of the commands at once and from that point on you can access the command by the command name only. 
For example, executing with inttrans  first will allow you to do the Laplace transform simply with the command laplace.

The benefit of the long form is that you are always sure of getting the command. The with approach saves on typing. 
Ultimately, it does come down to personal preference.

Go back to Table of Contents

2.7.1 Special Gotcha's for Control Systems

Maple has a few elements that often cause problems if you are doing work relating to control systems or signal processing.
The following are the most prominent.

Complex numbers: i vs. j

By default, Maple calls K1  as i. This is traditionally the letter used in mathematics. Within most of the engineering 
world, the preferred letter for the imaginary number is j as many want i reserved typically for electrical current. 
Furthermore, if you are typing out Maple commands that require i (i.e. j), you need to type I (capital i). Although there are 
techniques to switch definitions within Maple, the safest approach is still to use I.

ζ (damping coefficient vs. the Riemann "zeta" function)
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The ζ (Greek letter zeta) is used in virtually all control or engineering modeling contexts as a damping coefficient. Within 

Maple, ζ is reserved for something called the Riemann Zeta function. If you ever include a ζ into a Maple expression, 
chances are Maple will gladly accept the variable but give you totally incorrect results. Again there are ways to change 
Maple's behavior but that can cause uncertainty in your computations. The recommended option is to use the Greek letter 

ξ (xi) instead of ζ  for the damping coefficient -- i.e. a "double squiggle" instead of "single squiggle". You will find that the

look is very similar and there is no chance of conflict. The examples in these notes use the ξ.

Go back to Table of Contents

2.7.2 Formats and modes

Maple offers two basic styles of interaction: "Document" mode and "Worksheet" mode. Roughly speaking, Document 
mode is the modern Maple environment that allows greater levels of interaction and sophisticated mathematical word 
processing features. Conversely, the Worksheet mode is the traditional Maple environment where you typically type in a 
command, press [Enter], and Maple responds with the answer. This mode is still popular among those who program or 
those wishing to use older Maple worksheets from versions of Maple prior to Maple 10.

The newer versions of Maple (since Maple 10) supports both of these modes. This guide assumes that you are principally 
using the Document mode. This approach offers the nice benefit of all of the new "clickable", user-friendly options and 
when needed, you can still do modest amounts of programming.

The following is a brief summary of the various modes and mode options that you may wish to explore in the future.

The document mode lets you mix calculations, text, tables, graphics, and more in a single flexible environment. You 
typically enter math in what is referred to as 2D mode -- i.e. the math is laid out naturally. When you use this mode, your 
math information is easier to read and you have access to more interactive options. This is the mode that we use in these 
notes. When you first install Maple, you will be asked whether you want the default to be a Document or Worksheet. For 
the purposes of these notes, you should choose Document. In the File menu, under New, you can choose to create a new 
Document or Worksheet at any time. so you will not be stuck in the future with either choice.

The Worksheet mode is Maple's traditional environment that allows for basic command input and output and limited 
word-processing. In Worksheet mode, depending on your settings, you can either enter your commands in the linear "1D" 
or "red" form or the 2D form (as in the Document mode). The benefit of the first is that you can see exactly what you 
typed and the benefit of the second is that it is easier to read complicated math. You can switch between the 1D and 2D 
form with [ F5 ] or  the Text/Math toggle button on the toolbar -- i.e. in Worksheet mode, "Text" means 1D math, and 
"Math" means 2D math, somewhat analogous to the behavior of these toggles in document mode (i.e. regular text vs. 
executable math).
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3. Mathematical foundations

3.1 Complex variables

Operation
Clickable  

Imaginary and complex numbers. 

K1  is represented by the letter I 
(note that it is always capital), and 
not j or i. A complex number has the 
general form a Cb I.

K1

I (3.1.1)

1 C2 I

1 C2 I (3.1.2)

Complex arithmetic A d 1 C2 I

1 C2 I (3.1.3)

B dK3 K4 I

K3 K4 I (3.1.4)

A CB

K2 K2 I (3.1.5)

A B

5 K10 I (3.1.6)

A

B

K
11

25
K

2 I

25
(3.1.7)

A2

K3 C4 I (3.1.8)

Magnitude and phase are also 
referred to as the absolute value and 
argument.

Use the right click menu for the 
clickable operations.

In the expression palette there is also
a symbol a  which you can also use 
for the absolute value.

1 C2 I

1 C2 I (3.1.9)
absolute value

5

1 C2 I

1 C2 I (3.1.10)
complex argument

arctan 2 (3.1.11)

1 C2 I

5 (3.1.12)

Command version 

Ad 1 C2 I

1 C2 I

abs A

5

argument A

arctan 2
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3.2 Laplace transforms

The following are examples of computing Laplace transforms.

Operation
Clickable 

L sin 10 t sin 10 t

sin 10 t (3.2.1)
Laplace transform

10

s2 C100
(3.2.2)

Unit step and impulse functions 
(Heaviside step and Dirac delta 
functions).

Note: Maple's default notation for 

the step function is θ t .

From right-click menu, choose
Integral Transform → Laplace.
Choose t for transform variable and s 
for transform parameter.

Heaviside tK1

Heaviside tK1 (3.2.3)
Laplace transform

eKs

s

δ tK1

Dirac tK1 (3.2.4)
Laplace transform

eKs (3.2.5)

Derivatives

L
d

dt
y t  

The result produces a placeholder for
the transformed function Y s

d

d t
 y t

1

sC1 m
(3.2.6)

Laplace transform

s laplace y t , t, s Ky 0 (3.2.7)

In books, you would typically see this result expressed as, s Y s Ky 0 .

The following are examples of computing inverse Laplace transforms.

Operation
Clickable 

LK1
10

s2 C100

From the right-click menu, choose
Integral Transform → Inverse 
Laplace.

10

s2 C100

10

s2 C100
inverse Laplace transform

sin 10 t



Maple notes for introductory control systems 59

(3.3.1)(3.3.1)

(3.2.1.2)(3.2.1.2)

(3.2.9)(3.2.9)

(3.2.1.4)(3.2.1.4)

(3.2.1.1)(3.2.1.1)

(3.3.2)(3.3.2)

(3.2.1.5)(3.2.1.5)

(3.2.1.3)(3.2.1.3)

(3.2.1.6)(3.2.1.6)

LK1
eKs

s

eKs

s

eKs

s
inverse Laplace transform

Heaviside tK1

Command version 

inttrans laplace sin 10 t , t, s

10

s2 C100

inttrans laplace Heaviside tK1 , t, s

eKs

s

inttrans laplace Dirac tK1 , t, s

eKs

inttrans laplace diff y t , t , t, s

s laplace y t , t, s Ky 0

inttrans invlaplace
10

s2 C100
, s, t

sin 10 t

inttrans invlaplace
eKs

s
, s, t

Heaviside tK1

Go back to Table of Contents

3.3 Partial fraction expansions 

 Rewrite Y =
sC2  sC4

s sC1  sC3
 as a partial fraction expansion and obtain the inverse Laplace transform

Use the command convert  with the option parfrac. There is no menu access to this command.

Yd
sC2  sC4

s sC1  sC3

sC2  sC4

s sC1  sC3

convert Y, parfrac

8

3 s
K

1

6 sC3
K

3

2 sC1

This example uses the equation number (3.3.2)  i.e. the result of the expansion. Use [Ctl][l] to enter the number. Note that your 
equation number may vary.

inttrans invlaplace (3.3.2) , s, t
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(3.3.3)(3.3.3)

(3.4.1.2)(3.4.1.2)

(3.4.1.3)(3.4.1.3)

(3.4.1.1)(3.4.1.1)

8

3
K

eK3 t

6
K

3 eKt

2

One possible clickable approach would be to right-click on the expression and then choose Apply Command. You would then 
enter the name of the command (i.e. convert) and the argument (i.e. parfrac). In some ways, this is more cumbersome than 
simply typing the command.

Go back to Table of Contents

3.4 Final value theorem

Apply the final value theorem to obtain the steady state response of the system represented by the transfer function 

Y s =
3 sC2

s s2 C2 sC10
.

Operation
Clickable 

From the Expression palette choose [ 
lim

x/ a
f ] and make appropriate 

substitutions. Note the multiplication 
by s as required by the theorem. To 

get a decimal representation of 
3

5
 

use the right-click menu and choose
Approximate→5.

lim
s / 0

 
3 sC2

s s2 C2 sC10
 s

3

5
(3.4.1)

at 5 digits

0.60000 (3.4.2)

Command version 

Ysd
3 sC2

s s2 C2 sC10

3 sC2

s s2 C2 sC10

yssd limit s Ys, s = 0

3

5

evalf yss, 5

0.60000

Go back to Table of Contents
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(4.1.3)(4.1.3)

(4.1.2)(4.1.2)

(4.1.1)(4.1.1)

(4.1.4)(4.1.4)

(4.1.5)(4.1.5)

4. System representation

4.1 Getting the transfer function from the differential equation 

  Given the differential equation y
..

t C6 y
.

t C25 y t = 9 u t C3 u
.

t , determine the transfer function 

using first principles. 

NOTE: you should be able to do this problem by inspection (simply match the coefficients of the derivative terms with 
appropriate terms in the transfer function). So in reality, you shouldn't be using this technique. However, this example example
does illustrate a series of very important Maple techniques that will be useful for other problems. Note that this example is 
primarily a command-based approach. Although it is theoretically possible to do most with clickable techniques, you will find 
that they are fairly cumbersome and ultimately will require you to know the command set anyways. In this case the command 
approach is more intuitive and efficient.

Load the integral transforms library. The list returned is the set of functions now available to you.

with inttrans

addtable, fourier, fouriercos, fouriersin, hankel, hilbert, invfourier, invhilbert, invlaplace, invmellin, laplace, mellin,

savetable

Define the differential equation. Note that the variables y t  and u t  must explicitly be stated as functions of t. No space 
between y and t .

DEd diff y t , t, t C6 diff y t , t C25 y t = 9 u t C3 diff u t , t

d2

dt2
 y t C6 

d

dt
 y t C25 y t = 9 u t C3 

d

dt
 u t

Apply a Laplace transform to the whole equation. Note that the answer is in terms of s and the placeholders in the form
laplace y t , t, s  which is equivalent to L y t = Y s , and initial conditions. Note D y 0  is Maple's notation for the 
first derivative of y t .

 DEl d laplace DE, t, s

s2 laplace y t , t, s KD y 0 Ks y 0 C6 s laplace y t , t, s K6 y 0 C25 laplace y t , t, s

= 9 laplace u t , t, s C3 s laplace u t , t, s K3 u 0

Here is a trick to make the equation look more familiar. Replace the place holders for Y s  and U s , and apply the usual zero
initial conditions.

DEl d eval DEl, laplace y t , t, s = Y s , laplace u t , t, s = U s , y 0 = 0, D y 0 = 0, u 0 = 0

s2 Y s C6 s Y s C25 Y s = 9 U s C3 s U s

To obtain the transfer function, you need to determine 
Y s

U s
. Do this in two steps: isolate Y s  then divide the result by 

U s . Now simplify to cancel out the several U s  terms in the expression. 

Ysd isolate DEl, Y s

Y s =
9 U s C3 s U s

s2 C6 sC25

YsUsd
Ys

U s
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(4.2.1)(4.2.1)

(4.2.3)(4.2.3)

(4.1.6)(4.1.6)

(4.1.7)(4.1.7)

(4.2.2)(4.2.2)

(4.1.8)(4.1.8)

Y s

U s
=

9 U s C3 s U s

U s  s2 C6 sC25

TFd simplify YsUs

Y s

U s
=

3 3 Cs

s2 C6 sC25

The above is in a mathematical equation form (i.e. a = b . To get just the expression, extract the right hand side. Here we also 
overwrite the previous definition of the transfer function.

TFd rhs TF

3 3 Cs

s2 C6 sC25

Go back to Table of Contents

4.2 Using the DynamicSystems package for system 
representations

 Given a differential equation of a system  y
..

t C6 y
.

t C25 y t = 9 u t C3 u
.

t , use the

DynamicSystems package to obtain the transfer function and the state space representation. 

Load the DynamicSystems package

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable, PhaseMargin,

PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable, SSModelReduction,

SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System, SystemOptions, ToDiscrete,

TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

Assign the differential equation

DEd diff y t , t, t C6 diff y t , t C25 y t = 9 u t C3 diff u t , t

d2

dt2
 y t C6 

d

dt
 y t C25 y t = 9 u t C3 

d

dt
 u t

Convert to a proper DynamicSystems object. Maple returns a summary of the system. You can see the contents with the
PrintSystem function.

myDEd DiffEquation DE, u t , y t

Diff. Equation

continuous

1 output(s); 1 input(s)

inputvariable = u t

outputvariable = y t

PrintSystem myDE
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(4.2.7)(4.2.7)

(4.2.6)(4.2.6)

(4.2.5)(4.2.5)

(4.2.4)(4.2.4)

Diff. Equation

continuous

1 output(s); 1 input(s)

inputvariable = u t

outputvariable = y t

de = y
..

t C6 y
.

t C25 y t = 9 u t C3 u
.

t

Once you have the system in the right form, you can immediately convert to any of the primary modern forms with a single 
command.  Convert to a transfer function.

myTFd TransferFunction myDE

Transfer Function

continuous

1 output(s); 1 input(s)

inputvariable = u s

outputvariable = y s

PrintSystem myTF

Transfer Function

continuous

1 output(s); 1 input(s)

inputvariable = u s

outputvariable = y s

tf
1, 1

 = 
3 sC9

s2 C6 sC25

Generate the required matrices for the state space representation.

mySSd StateSpace myTF

State Space

continuous

1 output(s); 1 input(s); 2 state(s)

inputvariable = u t

outputvariable = y t

statevariable = x1 t , x2 t

PrintSystem mySS
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(4.2.13)(4.2.13)

(4.2.10)(4.2.10)

(4.2.9)(4.2.9)

(4.2.8)(4.2.8)

(4.2.12)(4.2.12)

(4.2.11)(4.2.11)

State Space

continuous

1 output(s); 1 input(s); 2 state(s)

inputvariable = u t

outputvariable = y t

statevariable = x1 t , x2 t

a = 
0 1

K25 K6

b = 
0

1

c = 9 3

d = 0

To get the transfer function expression out of the object, index on the parameter tf  (i.e.myTF tf . Maple returns, in this case, 
a 1 #1 matrix. This is because in complex systems, you can get multiple transfer functions expressed in a matrix. To get the 
function out as a simple expression, extract the [1,1] element of this matrix. 

myTF tf

3 sC9

s2 C6 sC25

myTF tf 1, 1

3 sC9

s2 C6 sC25

To access the statespace matrices, A, B, C, and D, index on the corresponding name in lower case. This example shows how to
get the matrix and use it to compose a statespace matrix expression.   Note, Maple chooses a different term order in the final 
equation. There's really not much you can do about that without resorting to very low-level programming.

mySS a

0 1

K25 K6

mySS b

0

1

d

d t
 x

1
t

d

d t
 x

2
t

= mySS a .

x
1

t

x
2

t
CmySS b  .u t

d

dt
 x

1
t

d

dt
 x

2
t

=
0

1
.u t C

x
2

t

K25 x
1

t K6 x
2

t

Go back to Table of Contents
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(4.3.1.1)(4.3.1.1)

4.3 Block diagrams

Closed loop transfer function for the following feedback system is 
G

1
G

2

1 CG
1
G

2

.

G
1

=
2 sC4

s
G

2
=

1

s
Σ

R Y

-

Operation
Clickable 

Define block expressions.

To use equation numbers, type [Ctl][l] 
(lower case L), then enter the equation 
number (note that yours may be 
different than this example).

For simplification, use Right Click 
menu.

2 sC4

s

2 sC4

s
(4.3.1)

1

s

1

s
(4.3.2)

(4.3.1)(4.3.2)

1 C (4.3.1)(4.3.2)

2 sC4

s2 1 C
2 sC4

s2

(4.3.3)

=
 simplify 

2 sC2

s2 C2 sC4

Command version 

G1d
2 sC4

s

G1d
2 sC4

s
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(4.3.1.2)(4.3.1.2)

(4.3.1.3)(4.3.1.3)

(4.3.1.4)(4.3.1.4)

G2d
1

s

G2d
1

s

TF d
G1 G2

1 CG1 G2

TFd
2 sC4

s2 1 C
2 sC4

s2

TFs d simplify TF

TFsd
2 sC2

s2 C2 sC4

Go back to Table of Contents
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(5.1.4)(5.1.4)

(5.1.5)(5.1.5)

(5.1.2)(5.1.2)

(5.1.1)(5.1.1)

(5.1.3)(5.1.3)

5. System response

5.1 Pole location and transient response

Operation
Clickable 

Define transfer function then use right click menu
Factor. Compute inverse Laplace transform by 
menu Integral Transforms→Laplace.Plot with 
menu Plot Builder. Ensure that plot time is 0 to 6.

2 sC1

s2 C3 sC2

2 sC1

s2 C3 sC2

=
 factor 

2 sC1

sC2  sC1
inverse Laplace transform

3 eK2 t KeKt

/

t

1 2 3 4 5 6
0

0.5

1

1.5

2

Copy and paste factored transfer function above 
to a new math line.

Change second factor to sK1 . Repeat steps 
and plot. 

To explore different real values of poles, simply 
change the factors and repeat the steps.

2 sC1

sC2  sK1

2 sC1

sC2  sK1
inverse Laplace transform

et CeK2 t

/
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(5.1.6)(5.1.6)

(5.1.7)(5.1.7)

t

0 1 2 3 4 5 6

100

200

300

400

To try complex poles, change the factor value to 
a complex number. Make sure that the two are 
complex conjugate pairs -- i.e. they only differ by
the sign of the imaginary term. 

2 sC1

sC1 C2 I  sC1 K2 I

2 sC1

sC1 C2 I  sC1 K2 I
inverse Laplace transform

eKt 4 cos 2 t Ksin 2 t

2

/

t

1 2 3 4 5 6

K0.5

0

0.5

1

1.5

2

Command version 

Hd
2 sC1

s2 C3 sC2
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(5.1.2.2)(5.1.2.2)

(5.1.2.3)(5.1.2.3)

(5.1.1.1)(5.1.1.1)

(5.1.1.3)(5.1.1.3)

(5.1.1.2)(5.1.1.2)

(5.1.2.1)(5.1.2.1)

2 sC1

s2 C3 sC2

Hf d factor H

2 sC1

sC2  sC1

htd inttrans invlaplace Hf, s, t

3 eK2 tKeKt

plot ht, t = 0 ..6

t

1 2 3 4 5 6
0

0.5

1

1.5

2

Go back to Table of Contents

5.1.1 Building exploration tools 

By using operators (functions), and other convenient Maple tools, you can easily try out different values of system 
parameters. This first example converts the previous example to operator form.

Operation
Clickable 

Using the Expression Palette, choose the 2 
parameter operator tool [ f := a, b /z  
and change the name from f to Hf and the 
expression z.

Hf d a, b /
2 sC1

sCa  sCb

a, b /
2 sC1

sCa  sCb

Now you can use the function Hf a, b  for 
different values of the poles. For example 
for the values 3 and 1. 

Use Inverse Laplace from menu and then
Plot Builder with range 0 to 10.

Hf 3, 1

2 sC1

sC3  sC1
inverse Laplace transform

eK2 t 2 cosh t K3 sinh t

/
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(5.1.2.5)(5.1.2.5)

(5.1.2.4)(5.1.2.4)

t

2 4 6 8 10
0

0.5

1

1.5

2

It will now work for any values. Note what 
happens when b ! 0. This implies the pole 
is on the right half plane and therefore the 
system is unstable. Hf 2,K1

2 sC1

sC2  sK1
inverse Laplace transform

etCeK2 t

/

t

0 2 4 6 8 10
0

5000

10000

15000

20000
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(5.1.2.1.2)(5.1.2.1.2)

(5.1.2.1.1)(5.1.2.1.1)

Maple is smart enough to deal with 
complex values of a and b.

Make sure they are complex conjugates -- i.
e. differ only be the sign of the imaginary 
term.

The complex poles will result in sines and 
cosines in the time response which will 
result in increased oscillation.

Hf 1 C2 I, 1 K2 I

2 sC1

sC1 C2 I  sC1 K2 I
(5.1.2.6)

inverse Laplace transform

eKt 4 cos 2 t Ksin 2 t

2
(5.1.2.7)

/

t

2 4 6 8 10

K0.5

0

0.5

1

1.5

2

Command version 

case1d Hf 3, 1

2 sC1

sC3  sC1

ytd inttrans invlaplace case1, s, t

eK2 t 2 cosh t K3 sinh t

plot yt, t = 0 ..10
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(5.1.2.1.4)(5.1.2.1.4)

(5.1.2.1.5)(5.1.2.1.5)

(5.1.2.1.3)(5.1.2.1.3)

(5.1.2.1.6)(5.1.2.1.6)

t

2 4 6 8 10
0

0.5

1

1.5

2

case2d Hf 2,K1

2 sC1

sC2  sK1

ytd inttrans invlaplace case2, s, t

eK2 tCet

plot yt, t = 0 ..10

t

0 2 4 6 8 10
0

5000

10000

15000

20000

case3d Hf 1 C2 I, 1 K2 I

2 sC1

sC1 C2 I  sC1 K2 I

ytd inttrans invlaplace case3, s, t

1

2
 eKt 4 cos 2 t Ksin 2 t

plot yt, t = 0 ..10
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(5.1.2.2.2)(5.1.2.2.2)

(5.1.2.2.1)(5.1.2.2.1)

t
2 4 6 8 10

K0.5

0

0.5

1

1.5

2

Version 2: More elaborate function 

Combine the full inverse Laplace transform command inside your operator function.

Hf2 d a, b / inttrans invlaplace
2 sC1

sCa  sCb
, s, t

a, b /inttrans
invlaplace

2 sC1

sCa  sCb
, s, t

Now when you call the function, you get the response expression in one step. You can now plot. Note, you could have 
placed the plot command inside the operator giving you a one step option right to the plot.

ytd Hf2 2, 1

KeKtC3 eK2 t

plot yt, t = 0 ..10

t

2 4 6 8 10
0

0.5

1

1.5

2

Go back to Table of Contents
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(5.2.1)(5.2.1)

(5.2.3)(5.2.3)

(5.2.2)(5.2.2)

5.2 Stability: Routh-Hurwitz criterion with the DynamicSystems 
package 

For the characteristic equation, s6 C4 s5 C3 s4 C2 s3 Cs2 C4 sC4 , generate the Routh table.

Load DynamicSystems package.

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable, PhaseMargin,

PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable, SSModelReduction,

SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System, SystemOptions, ToDiscrete,

TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

Define characteristic equation.

mypolyd s6 C4 s5 C3 s4 C2 s3 Cs2 C4 sC4

s6 C4 s5 C3 s4 C2 s3 Cs2 C4 sC4

Use RouthTable command.

RouthTable mypoly, s

1 3 1 4 s6

4 2 4 0 s5

5

2
0 4 0 s4

2 K
12

5
0 0 s3

3 4 0 0 s2

K
76

15
0 0 0 s

4 0 0 0 1

Go back to Table of Contents

5.2.1 Example: determining conditions for stability (Routh criterion) 

For the following feedback control system (PI controller), determine the conditions on Kp and Ki for which the system is 
stable.
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(5.2.1.1)(5.2.1.1)

(5.2.1.3)(5.2.1.3)

(5.2.1.4)(5.2.1.4)

(5.2.1.6)(5.2.1.6)

(5.2.1.2)(5.2.1.2)

Σ
R Y

-
KpC

Ki

s

1

sC1 sC2

Define transfer function as an equation TF s = 0. Maple does some initial rearrangement.

TF d 1 C KpC
Ki

s
 

1

sC1  sC2
= 0

1 C

KpC
Ki

s

sC1  sC2
= 0

simplify to get into a single rational on the left hand side.

TFd simplify TF

s3 C3 s2 C2 sCKp sCKi

s sC1  sC2
= 0

Extract the numerator of the left hand side of the above equation. This is the characteristic equation.

chareqd numer lhs TF

s3 C3 s2 C2 sCKp sCKi

Use RouthTable command as before leaving parameters undefined. The result is not completely useful as you will need to 
work with the elements to sort out conditions on Kp and Ki.

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable,

PhaseMargin, PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable,

SSModelReduction, SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System,

SystemOptions, ToDiscrete, TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

RouthTable chareq, s

1 2 CKp s3

3 Ki s2

2 CKpK
1

3
 Ki 0 s

Ki 0 1

RouthTable chareq, s, stablecondition = true

0 !Ki and 0 !6 C3 KpKKi

If you set the stablecondition option, you will get the conditions on your parameters that you will need to resolve. They 
appear as inequalities.
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(5.2.1.7)(5.2.1.7)

(5.2.1.8)(5.2.1.8)

(5.3.1.2)(5.3.1.2)

(5.3.1.1)(5.3.1.1)

ineqd 0 !6 C3 KpKKi

0 !6 C3 KpKKi

Maple can also solve inequalities. The result here is the condition relating Ki and Kp for which the system is stable.

solve ineq, Kp

K2 C
1

3
 Ki!Kp

Go back to Table of Contents

5.3 Root locus methods
Maple offers some very convenient tools for generating root locus plots and exploring the many useful concepts embodied in 
the technique.

5.3.1 Root locus plot with the DynamicSystems package 

Load the DynamicSystems package.

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable,

PhaseMargin, PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable,

SSModelReduction, SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System,

SystemOptions, ToDiscrete, TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

Define a new system using a transfer function. The NewSystem command returns a variation of the transfer function that is 
compatible with the other commands in the DynamicSystems package. 

G1d NewSystem
1

s s2 C8 sC32

Transfer Function

continuous

1 output(s); 1 input(s)

inputvariable = u1 s

outputvariable = y1 s

Call RootLocusPlot command. Default gain range is 0 to 10. In this case, the gain range is insufficient to provide 
meaningful root locus information.

RootLocusPlot G1
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(5.3.1.3)(5.3.1.3)

Re(s)

K7 K6 K5 K4 K3 K2 1 2

Im
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Try again for a gain range of 0 to 1000. The resulting plot is more complete.

RootLocusPlot G1, 0 ..1000

Re(s)

K10 K5 0 5

Im
(s

)

K10

K5

5

10

Using the option info=rlinfo, you can get useful, specific information. For example, the the Kbranches  provides the value 
of the gain where the locus splits.

G2d NewSystem
sK6

s s2 C4 sC13

Transfer Function

continuous

1 output(s); 1 input(s)

inputvariable = u1 s

outputvariable = y1 s

RootLocusPlot G2,K400 ..0, info = rlinfo
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Re(s)
K20 K10 0 10

Im
(s

)

K20

K10

10

20

print rlinfo

Record deq = deq =
d

dK
 s K = K

s K K6.

s K 2 C4. s K C13.Cs K  2 s K C4. CK
, charpoly = s s2

C4. sC13. CK sK6. , G =
sK6.

s3 C4. s2 C13. s
, Kcrit = , Kbranches = K382.2880836 , zeros

= 6. , poles = K2.000000000K3.000000000 I, K2.C3.000000000 I, 0.

rlinfo Kbranches

K382.2880836

rlinfo:-Kbranches

K382.2880836

Go back to Table of Contents

5.3.2 Discrete point approach to creating a root locus plot 

This example uses basic principles to create a root locus plot. A root locus plot traces the poles of the closed loop transfer 
function as some parameter (typically forward path gain K) varies within a range. Each time K changes, it changes the 
characteristic equation which then produces different roots (poles). So by systematically changing values of K and solving 
the resulting characteristic equation, then plotting the real and imaginary parts on a plot grid, you can construct a root 
locus plot point by point. Some of the advantages of this construction are greater flexibility, i.e. you can choose different 
parameters that impact the characteristic equation and not just the forward path gain, and the spacing of the plot points 
gives you valuable sensitivity information. That is, if a change in K produces pole positions that are far apart, this suggests 
the system is sensitive in that parameter range.

Define transfer function, and extract the characteristic polynomial. Note that we do not need to load the DynamicSystems 
package as we are "manually" constructing the root locus.

Gd
K

s s2 C8 sC32

K

s s2 C8 sC32

TFd simplify
K G

1 CK G

K2

s3 C8 s2 C32 sCK2

cpolyd denom TF

s3 C8 s2 C32 sCK2
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String together a "sequence" of the characteristic polynomials. A sequence is a Maple datastructure that is a collection of 
objects separated by a comma. E.g. a,b,c is a sequence. You can compose a sequence efficiently using the seq command. 

The result here is a sequence of all variations of the characteristic polynomial as K varies from 0 to 10 in increments of 1.

seq cpoly, K = 0 ..10

s3 C8 s2 C32 s, s3 C8 s2 C32 sC1, s3 C8 s2 C32 sC4, s3 C8 s2 C32 sC9, s3 C8 s2 C32 sC16, s3 C8 s2

C32 sC25, s3 C8 s2 C32 sC36, s3 C8 s2 C32 sC49, s3 C8 s2 C32 sC64, s3 C8 s2 C32 sC81, s3

C8 s2 C32 sC100

Try building a different sequence. Here, instead of stringing together the characteristic polynomials, try solving the 
polynomial and string together the computed roots. So each iteration of your sequence would have to do something like 
the following:

cpolytmpd eval cpoly, K = 2

s3 C8 s2 C32 sC4

solve cpolytmp

1

3
 586 C54 129

1/3
K

32

3 586 C54 129
1 /3

K
8

3
, K

1

6
 586 C54 129

1/3

C
16

3 586 C54 129
1/3

K
8

3
C

1

2
 I 3  

1

3
 586 C54 129

1/3
C

32

3 586 C54 129
1 /3

,

K
1

6
 586 C54 129

1 /3
C

16

3 586 C54 129
1/3

K
8

3
K

1

2
 I 3  

1

3
 586 C54 129

1/3

C
32

3 586 C54 129
1/3

The above commands will show you what one particular step in this sequence will give. The result of the complete 
sequence command is a very long sequence of complex numbers that represent the roots of all of the characteristic 
polynomials. For brevity in this print version of this guide, most of the output is omitted.

seq solve cpoly , K = 0 ..10

0,K4 C4 I,K4 K4 I,
1

6
 5012 C36 21001

1 /3
K

64

3 5012 C36 21001
1 /3

K
8

3
,K

1

12
 5012 C36 21001

1/3

C
32

3 5012 C36 21001
1/3

K
8

3
C

1

2
 I 3  

1

6
 5012 C36 21001

1/3

C
64

3 5012 C36 21001
1/3

,K
1

12
 5012 C36 21001

1 /3
C

32

3 5012 C36 21001
1/3

K
8

3

K
1

2
 I 3  

1

6
 5012 C36 21001

1 /3
C

64

3 5012 C36 21001
1/3

... 

 ... rest of the output is deleted for brevity

Using the complexplot command contained in the plots package, each complex number will plot as a point. For example, a 
value of 1 C2 I will plot as the point (1,2). Make sure you invoke the option style=point.

We now see some type of a root locus. The detail is pretty sparse though. 

plots complexplot seq solve cpoly, s , K = 0 ..10 , style = point
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Try the same thing but use a longer range of K. This time to 50.

plots complexplot seq solve cpoly, s , K = 0 ..50 , style = point

K14 K10 K6K4K20 2

K10

K5

5

10

Go back to Table of Contents

5.3.3 Discrete point example 2: exploring 2 parameters 

This is another example that takes the basic definition of the root locus (the trace of the roots of the characteristic equation 
as a parameter varies) and extends it to an analysis that is typically not easily achieved with more conventional treatments 
of the root locus. 

Consider again the following feedback system with a PI control:
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Σ
R Y

-

K s = KpC
Ki

s
G s =

1

sC1 sC2

The closed loop transfer function is 
K s  G s

1 CK s  G s
 and consequently, the characteristic equation 1 CK s  G s  is 

dependent on both Kp and Ki. The construction of the root locus from conventional methods will present several algebraic 
hurdles to sort through the math. The following simply adapts the exact same discrete point technique of the previous 
section in a way that visually treats the two parameters

Define closed loop transfer function and obtain the characteristic equation which is dependent on Kp and Ki.

TFd simplify

KpC
Ki

s
 

1

sC1  sC2

1 C KpC
Ki

s
 

1

sC1  sC2

Kp sCKi

s3 C3 s2 C2 sCKp sCKi

cpolyd denom TF

s3 C3 s2 C2 sCKp sCKi

Now define a Maple function that takes as input, Ki (using temporary variable name ki - lower case k), substitutes into the 
characteristic equation (which now becomes only a function of Kp since Ki has a value), then constructs a sequence within 
which the value of Kp is varied from 0 to 50 and for each value, you solve for the roots and through the sequence, you 
string together all of the solved roots. After this, you then pour the roots into the complexplot routine which will then create
and return a plot data structure. 

Remember this is a function definition so you will not get any results, just an echo of the function.

RLFd ki /plots complexplot seq solve eval cpoly, Ki = ki , s , Kp = 0 ..50 , style = point

ki/plots
complexplot

seq solve cpoly

Ki = ki

, s , Kp = 0 ..50 , style = point

Now that you have a function that returns a plot for each value of Ki, let's use this to string together a whole series of plots 
for different values of ki. To do this, you build another sequence, but this time you string entire plots together. At the end, 
you will have a total of 11 plots in datastructure form.

plotseqd seq RLF ki , ki = 0 ..10

PLOT ... , PLOT ... , PLOT ... , PLOT ... , PLOT ... , PLOT ... , PLOT ... , PLOT ... , PLOT ... ,

PLOT ... , PLOT ...

Now you need a way to view all of these plots. By using the display function in the plots package. The default simply 
shows all of the plots together at the same time.

plots display plotseq
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With an insequence=true setting, you can create an animation that treats each plot as a frame. Execute this 

command and you will get the first frame. Then click on the plot. You will then see a slider control on the tool bar. 

  Use this control to move the animation.

plots display plotseq, insequence = true

K3 K2 K1 0

K6

K4

K2

2

4

6

If you survived this exercise and you are comfortable with all of the commands and the steps, you are well on your way to 
becoming a Maple master! Being able to freely and efficiently mix math, graphics, programming, and interactive tools to 
solve complex problems that are typically impossible with traditional math or programming systems is really the most 
powerful Maple skill that you can achieve. Congratulations ... it is now time for you to leave Grasshopper ... for and 
explanation of this obscure reference, see   http://www.imdb.com/title/tt0068823/quotes and http://en.wikipedia.
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org/wiki/Kung_Fu_(TV_series) ☺

Go back to Table of Contents

5.4 Frequency domain analysis: Bode plots

5.4.1 Example: Time domain response to input sin a t

Operation
Clickable  

Define transfer function G s . 

Gd
1

sC1

1

sC1

Define the input function as a sine 
wave with a frequency parameter a. 
Get the inverse Laplace transform 
through the menu and assign to a 

name Rs.

rtd sin a t

sin a t
Laplace transform

a

s2 Ca2

assign to a name

a

s2 Ca2

The output in Laplace domain will 
be the product of the system 
transfer function and the input. 

Compute the product, get the 
inverse Laplace transform. This is 
now the general formula of the 
response of the system to a general 
sine wave input. 

Give this a name yt.

Yd G Rs

a

sC1  s2 Ca2

inverse Laplace transform

sin a t C eKtKcos a t  a

1 Ca2

assign to a name

sin a t C eKtKcos a t  a

1 Ca2

Create a function so that you can 
quickly evaluate yt at any value of 

a. Use the f := a / y in the 
expression palette and use copy and
past from the previous result to 
define this function.

ytfd a /  
sin a t Ca Kcos a t CeKt

1 Ca2
 

a/
sin a t Ca Kcos a t CeKt

1 Ca2

Try a = 10. and plot using the menu 

and Plotbuilder.
ytf 10

sin 10 t

101
K

10 cos 10 t

101
C

10 eKt

101

/
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K0.05

0
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Wrap a plot   , t = 0 ..10  around 
the general expression for the 
response. Right click and choose

Explore. 

You will then get a dialog box. 
Change the "to" value from 10 to 
10.0. This will tell Maple that you 
are interested in values of a that are 
non-integer.

This generates a new 
document with an Exploration 

Assistant. With this tool, you 
can simply slide a value of a 
and see the resulting plot.

This is a general convenience tool 
that can be used for a wide range of 
Maple objects that depend on 
parameters.

plot
sin a t Ca Kcos a t CeKt

1 Ca2
, t = 0 ..10

Command Version 
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Gd
1

sC1

1

sC1

rtd sin a t

sin a t

Rs d inttrans laplace rt, t, s

a

s2 Ca2

Yd G Rs

a

sC1  s2 Ca2

ytd inttrans invlaplace Y, s, t

sin a t C eKt Kcos a t  a

1 Ca2

ytfd unapply yt, a

a/
sin a t C eKtKcos a t  a

1 Ca2

plot ytf 10 , t = 0 ..10

t

2 4 6 8 10

K0.05

0

0.05

0.10

0.15

Explore plot
sin a t Ca Kcos a t CeKt

1 Ca2
, t = 0 ..10
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Go back to Table of Contents

5.4.2 Bode plots using the DynamicSystems package 

Load DynamicSystems package.

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable,

PhaseMargin, PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable,

SSModelReduction, SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System,

SystemOptions, ToDiscrete, TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

Define a transfer function as a system compatible with the DynamicSystems package.

KGsd NewSystem
0.01 s2 C0.01 sC1

s2 
s2

4
C

0.02 s

2
C1

Transfer Function

continuous

1 output(s); 1 input(s)

inputvariable = u1 s

outputvariable = y1 s

Construct the Bode plots.

BodePlot KGs
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5.4.3 Manual construction of Bode plots for a lead compensator 

This is an illustrative example showing how your can use fundamental principles to construct a Bode plot step by step. It 

exploits the fact that the Bode plot is a special complex plot of the function that results when s = i ω where ω is the 
frequency variable in radians.

Define a transfer function.

TFd
sC1

.1 sC1

sC1

0.1 sC1

Let s = i ω

TFomegad eval TF, s = I ω

I ωC1

0.1 I ωC1

Convert function to Hertz with ω = 2 π f where f is now the new frequency variable in Hertz.

TFfd eval TFomega, ω = 2 π f

2 I π fC1

0.2 I π fC1

.

Compute the magnitude of the function. The Maple command is abs. The command evalc tells Maple to apply special 
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rules pertaining to complex numbers and functions to compute the magnitude and phase.

magd abs TFf

2 I π fC1

0.2 I π fC1

magcd evalc mag

1

1 C0.04 π
2
 f2

C
0.4 π

2
 f2

1 C0.04 π
2
 f2

2

C
3.24 π

2
 f2

1 C0.04 π2
 f2

2

Repeat for the phase. The Maple command for phase is argument.

phased argument TFf

argument
2 I π fC1

0.2 I π fC1

phasecd evalc phase

arctan
1.8 π f

1 C0.04 π
2
 f2

,
1

1 C0.04 π
2
 f2

C
0.4 π

2
 f2

1 C0.04 π
2
 f2

Use the semilogplot command from the plots package to plot on a logarithmic axis on the horizontal. To obtain dBs on the 

vertical, plot 20 log
10

f.

plots semilogplot 20$ log 10 magc , f = .01 ..100, gridlines = true

f

0.01 0.1 1 10 100

2

4

6

8

10

12

14

16

18

20

Repeat for phase without the dB conversion calculation of course.

plots semilogplot phasec, f = .01 ..100, gridlines = true
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5.4.4 Bode plot exploration tool 

This is an example of how Maple can be configured to provide easy to use interactive tools for complex processes. 
Directly enter or copy a transfer function into the math "container" and press the "Bode Plot" button below the plot region. 
If you want to see how this tool is made, open the "If you want to see the code" section.

1

sC2

Freq [rad/s]
0.01 0.1 0.4 1 2 46102040100

M
ag

n
it

u
d

e 
[d

B
]

K40

K35

K30

K25

K20

K15

K10

Freq [rad/s]
0.01 0.1 0.4 1 2 46102040100

P
h
as

e 
[d

eg
.]

K80

K60

K40

K10

Bode Plot
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If you want to see the code 

The following code is inserted into the "Bode Plot" button definition. To access, right-click on the button and choose
Component Properties→Edit.

use DocumentTools in 

  Do( tf=%transferfunction );

  tfs := DynamicSystems[NewSystem](tf);

  Do(%bodeplotregion = DynamicSystems[BodePlot](tfs));

end use; 

Go back to Table of Contents

5.5 Frequency domain analysis: Nyquist plots 

Unfortunately, Maple 12 has limited tools for Nyquist plots of frequency response. The following are two examples of certain 
Nyquist operations you can do with the current version.

5.5.1 Example: 
1

sC1
2

 

Define G as a proper Maple function of s. This will make it convenient to evaluate the function for different values of i ω.

Gd s/
1

sC1 2

s/
1

sC1 2

Use the complexplot command of the plots package that will reference the real values to the horizontal axis and imaginary 
values to the vertical axis.

plots complexplot G I ω , ω =K100 .. 100

0 0.2 0.4 0.6 0.8

K0.6

K0.4

K0.2

0.2

0.4

0.6
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Note the above plot is a bit course on the right. Increasing the number of plotting points smoothes this out.

plots complexplot G I ω , ω =K100 .. 100, numpoints = 200

0 0.2 0.4 0.6 0.8 1

K0.6

K0.4

K0.2

0.2

0.4

0.6

Go back to Table of Contents

5.5.2 Example: 
1

s sC1
2  

This is a more difficult example.

Define function and plot as before. The resulting plot is not very useful as this Nyquist plot tends to infinity. 

Gd s/
1

s sC1 2

s/
1

s sC1 2

plots complexplot G I ω , ω =K100 .. 100, numpoints = 200

K2 K1.5 K1 K0.5 0

K500

K400

K300

K200

K100

Try plotting only the negative values of frequency. Try ω =K100 to 0. This time, the plot looks better but lacks the detail 
near the origin which is a very important region for Nyquist analysis.
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plots complexplot G I ω , ω =K100 .. 0, numpoints = 200

K1.8 K1.4 K1 K0.6 K0.2 0

10

20

30

40

50

60

Now try restricting the view of the plot to around the origin. change the view option within the complexplot command. 
Now you get a good sense of the behavior near the origin.

plots complexplot G I ω , ω =K100 .. 0, numpoints = 200, view = K2 ..1,K2 ..2

K2 K1 0 1

K2

K1

1

2

Repeat for positive frequencies. Combined, this and the previous plot constitute the the complete Nyquist plot for the 
region near the origin.

plots complexplot G I ω , ω = 0 .. 100, numpoints = 200, view = K2 ..1,K2 ..2
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 Note: One way to combine the two plots is simply to drag and drop one graph to the other. Click on the actual 

curve that you want to move then simply drag and drop. If you want to preserve the original plot, press [Ctl] on a Windows
system when you drag. This is called a "drag copy". The following plot was created in such a way.

K2 K1 0 1

K2

K1

1

2

Go back to Table of Contents
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6. PID Control

6.1 DC Motor definition

This example shows the development of the closed-loop transfer function for  

Σ
R Y

-

K s =

KpC
Ki

s
Ck

d
 s

G s = 
K

t

J
m
 sCb  L

a
 sCR

a
CK

t
 K

e

Operation
Clickable 

Define transfer function for 
both the motor plant (G s ) 
and the controller K s  
(named PID in this example). 

Assign to a name G and PID 
respectively.

Assemble the closed loop 
transfer function.

K
t

J
m

 sCb  L
a
 sCR

a
 CK

t
 K

e

K
t

J
m

 sCb  L
a
 sCR

a
CK

t
 K

e

(6.1.1)

assign to a name

K
t

J
m
 sCb  L

a
 sCR

a
CK

t
 K

e

k
p
C

k
i

s
Ck

d
 s

k
p
C

k
i

s
Ck

d
 s (6.1.2)

assign to a name

k
p
C

k
i

s
Ck

d
 s

G PID

1 CG PID

K
t
 k

p
C

k
i

s
Ck

d
 s

J
m

 sCb  L
a
 sCR

a
CK

t
 K

e
 1 C

K
t
 k

p
C

k
i

s
Ck

d
 s

J
m
 sCb  L

a
 sCR

a
CK

t
 K

e

(6.1.3)

Given the transfer function,  
normalize the function (i.e. 
make it a simpler algebraic 

normal
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fraction) and rearrange the 
denominator with respect to s.
This will make the 
characteristic equation 
coefficients more readable.

K
t
 k

p
 sCk

i
Ck

d
 s2

J
m

 s3 L
a
CJ

m
 s2 R

a
Cb L

a
 s2 Cs b R

a
Cs K

t
 K

e
CK

t
 k

p
 sCK

t
 k

i
CK

t
 k

d
 s2

=
 collect w.r.t. s 

K
t
 k

p
 sCk

i
Ck

d
 s2

J
m

 s3 L
a
C J

m
 R

a
Cb L

a
CK

t
 k

d
 s2 C K

t
 K

e
CK

t
 k

p
Cb R

a
 sCK

t
 k

i

Use the f x

x = a

 tool in 

the Expression Palette. Copy 
and paste the previous result 
(the transfer function), and 
specify the values of the 
various parameters.

K
t
 k

p
 sCk

i
Ck

d
 s2

J
m
 s3 L

a
C J

m
 R

a
Cb L

a
CK

t
 k

d
 s2 C K

t
 K

e
CK

t
 k

p
Cb R

a
 sCK

t
 k

i

J
m

= 1.13 10K2, b = 0.028, L
a

= 10K1, R
a

= 0.45, K
t
= 0.067, K

e
= 0.067

0.067 k
p
 sCk

i
Ck

d
 s2 0.001130000000 s3 C 0.007885000000

C0.067 k
d

 s2 C 0.017089C0.067 k
p

 sC0.067 k
i

assign to a name

0.067 k
p
 sCk

i
Ck

d
 s2 0.001130000000 s3 C 0.007885000000

C0.067 k
d

 s2 C 0.017089C0.067 k
p

 sC0.067 k
i

Specify the input as a step 

function (U s =
1

s
) and 

multiply with the closed loop 
transfer function to obtain the 
output Y s .

1

s
 TF

0.067 k
p
 sCk

i
Ck

d
 s2 s 0.001130000000 s3 C 0.007885000000

C0.067 k
d

 s2 C 0.017089C0.067 k
p

 sC0.067 k
i

Specify controller parameter 
values.

0.067 3 sC15 C0.15 s2

s 0.001130000000 s3 C0.01793500000 s2 C0.218089 sC1.005

k
p

= 3, k
i

= 15, k
d

= 0.15 

0.067 3 sC15 C0.15 s2

s 0.001130000000 s3 C0.01793500000 s2 C0.218089 sC1.005

Compute the inverse Laplace 
transform using the right click
menu, Integral 
Transforms→Inverse 
Laplace. Choose defaults for 
variables when dialog 
appears.

With the right-click, Plot 
Builder, plot the time 
response function with t from 
0 to 6.0.

inverse Laplace transform

K0.1186250615 eK6.769420173 tC K0.4406874693

C0.1938949778 I  e K4.551130621K10.51994744 I  tK 0.4406874693

C0.1938949778 I  e K4.551130621C10.51994744 I  tC1

/
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(6.1.1.2)(6.1.1.2)

(6.1.1.5)(6.1.1.5)

(6.1.1.1)(6.1.1.1)

(6.1.1.4)(6.1.1.4)

(6.1.1.3)(6.1.1.3)

t

0 1 2 3 4 5 6
0
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0.4

0.6

0.8

1

1.2

Command Version 

Gd

K
t

  J
m

 sCb  L
a
 sCR

a
 C K

t
 K

e

K
t

J
m

 sCb  L
a
 sCR

a
CK

t
 K

e

PIDd k
p
C

k
i

s
 Ck

d
 s

k
p
C

k
i

s
Ck

d
 s

TFd
G PID

1 CG PID

K
t
 k

p
C

k
i

s
Ck

d
 s

J
m

 sCb  L
a
 sCR

a
CK

t
 K

e
 1 C

K
t
 k

p
C

k
i

s
Ck

d
 s

J
m
 sCb  L

a
 sCR

a
CK

t
 K

e

TFd collect  normal TF , s

K
t
 k

p
 sCk

i
Ck

d
 s2

J
m
 s3 L

a
C J

m
 R

a
Cb L

a
CK

t
 k

d
 s2 C K

t
 K

e
CK

t
 k

p
Cb R

a
 sCK

t
 k

i

TF d eval TF, J
m

= 1.13 10K2, b = 0.028, L
a

= 10K1, R
a

= 0.45, K
t

= 0.067, K
e

= 0.067

0.067 k
p
 sCk

i
Ck

d
 s2

0.001130000000 s3 C 0.007885000000C0.067 k
d

 s2 C 0.017089C0.067 k
p

 sC0.067 k
i
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(6.1.1.7)(6.1.1.7)

(6.1.1.6)(6.1.1.6)

1. 1. 

3. 3. 
4. 4. 

2. 2. 

Ysd
1

s
 TF

0.067 k
p
 sCk

i
Ck

d
 s2

s 0.001130000000 s3 C 0.007885000000C0.067 k
d

 s2 C 0.017089C0.067 k
p

 sC0.067 k
i

Ysd eval Ys,  k
p

= 3, k
i
= 15, k

d
= 0.15

0.067 3 sC15 C0.15 s2

s 0.001130000000 s3 C0.01793500000 s2 C0.218089 sC1.005

plot inttrans invlaplace Ys, s, t , t = 0 ..6

t

0 1 2 3 4 5 6
0

0.2

0.4

0.6

0.8

1

1.2

Go back to Table of Contents

6.2 PID Exploration tool 

This is an example of using some of Maple's interactive user interface building tools (Components palette) to create a user-
friendly tool that removes the need to know any commands or menu options. 

For this example:

Compute the closed loop transfer function as in the previous example
Copy and paste the transfer function into the first region
Specify numerical values for the controller parameters
Press the [Response plot] button to compute the time response expression and the response plot

If you want to see the details of this example, look at the subsection "If you want to see the code" following this tool.
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Copy transfer function expression into here

0.067 k
p
 sCk

i
Ck

d
 s2

0.001130000000 s3C 0.007885000000C0.067 k
d

 s2C 0.017089C0.067 k
p

 sC0.067 k
i

 s

Time response expression

0.9216K0.9218 eK7.936 t cos 11.40 t C0.1386 eK7.936 t sin 11.40 t

Enter controller parameters (do not leave any parameter blank. Use 0.0 value instead)

  k
p
  

3
   k

i
  

0.0
    k

d

0.15
       

Response plot

t
0 1 2 3 4 5 6

0

0.2

0.4

0.6

0.8

1

Go back to Table of Contents

If you want to see the code 

The following code is inserted into the "Response Plot" button definition. To access, right-click on the button and choose
Component Properties→Edit.

use DocumentTools in 

  

  # get PID values

  Do(k[p] = %kp); 

  Do(k[i] = %ki);

  Do(k[d] = %kd);

  

  # final transfer function
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(7.1.1)(7.1.1)

(7.1.2)(7.1.2)

  rs := 1/s;                 

  Do(tf = %transferfunction); 

  ys := rs * tf;

  

  # inverse Laplace transform

  yt := evalf(simplify(inttrans[invlaplace](tf,s,t)),4);

  

  # put results in the expression and plot containers.

  Do(%responseexpression = yt);

  Do(%responseplot = plot([yt,Heaviside(t)],t=0..6));

end use; 

To access any other definitions of components, simply right-click on the region or object and look up the properties. You 
will notice that the button is the only object that actually has any "smarts" all other objects simply take in or display 
information.

7. State Space Representation

7.1 Obtaining state space matrices with DynamicSystems package

Convert the transfer function 
sC2

s2 C7 sC12
 and assemble the state space equation x

.
= A x CB u t .

Load the DynamicSystems package.

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable, PhaseMargin,

PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable, SSModelReduction,

SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System, SystemOptions, ToDiscrete,

TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

Convert the transfer function to state space form. To actually see the various matrices, use the PrintSystem command. Store the
result in the variable SS. Note the labels for the 4 state space matrices A, B, C, D. You will need these for the next steps.

SS d StateSpace
sC2

s2 C7 sC12

State Space

continuous

1 output(s); 1 input(s); 2 state(s)

inputvariable = u1 t

outputvariable = y1 t

statevariable = x1 t , x2 t

PrintSystem SS
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(7.1.6)(7.1.6)

(7.1.4)(7.1.4)

(7.1.3)(7.1.3)

(7.1.5)(7.1.5)

State Space

continuous

1 output(s); 1 input(s); 2 state(s)

inputvariable = u1 t

outputvariable = y1 t

statevariable = x1 t , x2 t

a = 
0 1

K12 K7

b = 
0

1

c = 2 1

d = 0

Define the two vectors that you need for the general equation x
.

= A x CB u t .To enter the variable x
1

.
, make sure you are 

in math mode, then type [ x ] [ _ ] (underscore) [ 1 ] [ → ] (right cursor). You should now see x
1
. Now type, [ shift ][ ctl ] (hold

both) [ " ]. The cursor will move to the top of the x. Now type [ . ] (period) for the dot.  Finish with [ → ].

xdotvecd

d

d t
 x

1
t

d

d t
 x

2
t

d

dt
 x

1
t

d

dt
 x

2
t

xvecd

x
1

t

x
2

t

x
1

t

x
2

t

To get and use the matrix definitions:

stateeqs d xdotvec = SS a .xvecC SS b .u t

d

dt
 x

1
t

d

dt
 x

2
t

=
0

1
.u t C

x
2

t

K12 x
1

t K7 x
2

t

Go back to Table of Contents

7.2 Controllability and observability with the DynamicSystems 
package

Load DynamicSystems package.
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(7.2.3)(7.2.3)

(7.2.5)(7.2.5)

(7.2.2)(7.2.2)

(7.2.4)(7.2.4)

(7.2.1)(7.2.1)

(7.2.7)(7.2.7)

(7.2.6)(7.2.6)

with DynamicSystems

AlgEquation, BodePlot, CharacteristicPolynomial, Chirp, Coefficients, ControllabilityMatrix, Controllable,

DiffEquation, DiscretePlot, FrequencyResponse, GainMargin, Grammians, ImpulseResponse,

ImpulseResponsePlot, IsSystem, MagnitudePlot, NewSystem, ObservabilityMatrix, Observable, PhaseMargin,

PhasePlot, PrintSystem, Ramp, ResponsePlot, RootContourPlot, RootLocusPlot, RouthTable, SSModelReduction,

SSTransformation, Simulate, Sinc, Sine, Square, StateSpace, Step, System, SystemOptions, ToDiscrete,

TransferFunction, Triangle, Verify, ZeroPoleGain, ZeroPolePlot

Define a transfer function of a system. Convert to state space form using the StateSpace command.

sysd StateSpace
1

s2 CsC10

State Space

continuous

1 output(s); 1 input(s); 2 state(s)

inputvariable = u1 t

outputvariable = y1 t

statevariable = x1 t , x2 t

Generate the required matrices.

ControllabilityMatrix sys

0 1

1 K1

ObservabilityMatrix sys

1 0

0 1

Query to see if the system is controllable or observable

Controllable sys

true

Observable sys

true

For this example, use a matrix definition of the state space model.

sysmd StateSpace

K3 1 0

K5 0 1

K3 0 0

, 

1

2

3

, 1 0 0 , 0

State Space

continuous

1 output(s); 1 input(s); 3 state(s)

inputvariable = u1 t

outputvariable = y1 t

statevariable = x1 t , x2 t , x3 t

ControllabilityMatrix sysm
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(7.2.8)(7.2.8)

(7.2.9)(7.2.9)

1 K1 1

2 K2 2

3 K3 3

Controllable sysm

false

Go back to Table of Contents


